Contents

Chapter 1
- Outline ............................................................................................................................................................ 3
- Basic concept of SRP Player Pro .................................................................................................................. 4
- Types of model data ................................................................................................................................... 5
- Terminology of SRP Player Pro .................................................................................................................. 7
- Description of the names related to modeling machine and SRP Player Pro data .................. 8
- Description of CL (milling data) created by SRP Player Pro ...................................................................... 9

Chapter 2
- Basic Operation .........................................................................................................................................11
- Starting & ending of SRP Player Pro .......................................................................................................12
- Screen and names of SRP Player Pro ......................................................................................................13
- How to use a mouse on SRP Player Pro ..................................................................................................14
- Flow of data preparation by SRP Player Pro ...........................................................................................15
- Preferences ..................................................................................................................................................16
- Preparation of new SRP Player Pro data .................................................................................................17
- Layer function ............................................................................................................................................20
- Preparation of new workpiece ..................................................................................................................21
- Preparation of a project ............................................................................................................................24
- CL generation .............................................................................................................................................35
- CL Data Show Control ................................................................................................................................38

Chapter 3
- Profile Description....................................................................................................................................39
- Types of profile ..........................................................................................................................................40
- Profile Menu .............................................................................................................................................41
- Roughing (Z-level) ....................................................................................................................................42
- Finishing (Z-level) ...................................................................................................................................58
- Finishing (Scanning-line) ..........................................................................................................................72
- Edge Cutting .............................................................................................................................................78
- Curve Cutting ...........................................................................................................................................82
## Contents

### Chapter 4
- Profile Initial Values ........................................................................................................................................87
  - About profile initial values ..........................................................................................................................88
  - Roughing (Z-level) ..........................................................................................................................................90
  - Finishing (Z-level) ...........................................................................................................................................96
  - Finishing (Scanning-line) .............................................................................................................................99
  - Edge Cutting ..................................................................................................................................................102
  - Curve Cutting ...............................................................................................................................................106

### Chapter 5
- Common Items .............................................................................................................................................109
  - Description of other operations .............................................................................................................110
  - Wall Property .................................................................................................................................................114
  - Support Library .............................................................................................................................................115
  - Edit Project .....................................................................................................................................................118
  - Cut Off Area ................................................................................................................................................121
  - Change Tool ..................................................................................................................................................129
  - Project Template .........................................................................................................................................134
  - Virtual Parting Plane ...................................................................................................................................141

### Chapter 6
- Optimization .................................................................................................................................................143
  - Optimizing CL Data .....................................................................................................................................144
  - Elimination of Air Cut /Optimize Auto Clearance .............................................................................145

### Chapter 7
- Edit Registered Data ...................................................................................................................................147
  - Registration and Edit ..................................................................................................................................148
  - Tool Type .......................................................................................................................................................149
  - Tools ..............................................................................................................................................................150
  - Material/Milling Conditions .....................................................................................................................152
  - Workpiece Size ...........................................................................................................................................153
  - To input a combination of material and tool according to cut conditions information ....154
Outline
What is SRP Player Pro?

It is a 3 dimensional CAM module, by which a cutter path having high quality can be created without difficulty, by making use of many 3D modeler data including Rhinoceros and others.

◆ Making use of 3D modeler data

You cannot make any graphic using SRP Player Pro. You should retrieve (import) those graphics created by other applications software and add milling conditions to them to output the milling data.

Types of files SRP Player Pro available on

<table>
<thead>
<tr>
<th>Types of files</th>
<th>Version &amp; File Format</th>
<th>Elements possible to be retrieved</th>
</tr>
</thead>
<tbody>
<tr>
<td>Craft MILL file</td>
<td>Craft MILL Plus R</td>
<td>All</td>
</tr>
<tr>
<td>IGES file (Inutial Graphics Exchange Specification)</td>
<td>IGESV5.1 * In compliance with JAMA-IS All images output with NURBS (Type 128)</td>
<td>Curved surface and curved line</td>
</tr>
<tr>
<td>Rhino file</td>
<td>Rhino 1.0 / 1.1 / 2.0 / 3.0</td>
<td>Curved surface, curved line and polygon mesh</td>
</tr>
<tr>
<td>STL file (Stereolithography Interface Format)</td>
<td>Both of Binary and ASCII formats can be retrieved.</td>
<td>Triangle polygon conglomerate</td>
</tr>
<tr>
<td>DXF file</td>
<td>3D polygon data of DXF file</td>
<td>3D polygon data of DXF file</td>
</tr>
</tbody>
</table>
• Difference of the finish by subject model data
  Depending on the type of data being output from CAD/CG, the finish after cutting process varies. The difference of the finish by data is described below.

  Difference between curved surface data and polygon data

• Curved surface is able to describe the details in an accurate and smooth fashion
  SRP Player Pro, which creates a path by directly using the curved surface
  The reproducibility of curved surface is extremely excellent and a smooth finish can be secured.

  *Because most of 3DCAM software once converts first the read curved surface into polygon. Therefore even the surface data has been read, it is processed as polygon data at the stage of internal milling. The finish becomes the level equivalent to the state polygon data has been cut.

• Polygon data, which describes the graphic by polygon mesh (polyhedron approximate), performs smooth shading in the display milling and describes it in visually a smooth fashion
  Although the calculation is performed very quick, tolerance against curved line occurs.
  The accuracy in finish is just the same as the accuracy of polygon finish.
  (If you use the “Polygon smoothing function” installed on SRP Player Pro, you can approximate the rough polygon finish to curved surface data also, because smoothing milling is performed to the polygon to create a path.)
**Chapter 1**

Large volume polygon data, which is created by describing in details the smooth and actual shape, created with point group measuring device such as 3D scanner, etc.

Smooth curved surface shape has been shown with a polygon mesh keeping its high accuracy. Therefore, high accuracy can be secured in the finish, but it becomes extremely huge size. CAM software used in general may be able unavailable. SRP Player Pro has been developed and improved in order to process large volume polygon model as well.

Selected the data output method far different purposes by capturing each performance is also an important process.

Above figure is a screen in which STL of 650,000 polygon and jigs required for milling were built with a surface and read. SRP Player Pro can process both a curved surface and a polygon together.

Following difference is shown as a result of milling by SRP Player Pro.

- Long: Computing time required by PC
- Short: Accuracy of finish after milling
- High: Accuracy of finish after milling
- Low: Accuracy of finish after milling
SRP Player Pro basic training text

Outline

Terminology of SRP Player Pro

◆Description of the words and terms used for SRP Player Pro

Workpiece:
- Means in general the materials to be processed
  - Size and location are defined for the workpiece by SRP Player Pro.
  - A project is created by organizing the milling methods of this workpiece together and milling data is created.

Project:
- The direction to process a workpiece is determined and the process to be processed is controlled.

Profile:
- A milling process, which is collectively kept under control in a project.

Current:
- The workpiece, project and profile currently being created are respectively called as a current workpiece, current project and current profile.

Contour:
- Means a silhouette line at a certain height of a model being processed in SRP Player Pro, a certain part of CL height is called as a contour also.

Model Coordinate system:
- Means a coordinate system of model data created by a curved surface or a polygon, also called as a world coordinate system.

Project Coordinate system:
- A coordinate system based on the milling orientation and origin against the defined workpiece. This origin becomes as a milling origin.

Allowance:
- Means an excess material thickness to be left unprocessed for the final milling shape
  - Except for curve cutting, CL is generated in such a manner that even thickness can be secured in material direction to the milling shape.
  - In case of curve cutting, the thickness is adjusted in the height direction only.

NC:
- An abbreviation of Numerical Control. This means the data that controls milling machines. This format is called as G-code.

CL:
- An abbreviation of Cutter Location. This means the track of the toll movement. One (1) CL is generated from one (1) profile.

CL data:
- Means the data to be output to milling machine for which CL has been formatted according to that milling machine.

Tool Initial Position:
- Means the position of a tool when milling should start
  - X-Y coordinate values at the tool original position by SRP Player Pro are located based on the project origin. Only the Z coordinate values are located at the height determined based on the workpiece upper face as a reference surface.

Clearance height:
- When generating CL, the tool position is moved up to a height to prevent the tool from interfering with the item being processed when that tool moves from a certain cutting section to the next cutting section. The height in this case is called as a clearance height.
  - The clearance height by SRP Player Pro is the height determined based on the workpiece upper face as a reference surface.
Chapter 1
SRP Player Pro basic training text

Outline

Description of the names related to modeling machine and SRP Player Pro data

• Collation of the names related to modeling machine and data

Relationship between the names related to modeling machine and data

Modeling machine

Workpiece (material):
Means the material used to cutout a model. Milling data is created to cutout a model from a square block. It is important to match the size of actual material with the size of a workpiece on the data.

X-Y-Z origin & project origin:
The origins (XO/YO/ZO) which should become the reference positions for milling by a modeling machine are matched with the process origin on the data (project origin).

Back up board:
If you put a workpiece material directly on the moving table of a modeling machine, such troubles would occur that the table must be cut when milling the portion below the workpiece is required or the parallel cannot be secured, etc.
In order to prevent this, affix a material having a role as a back up board on the table and secure the facing, by which the parallel accuracy is secured and permits milling below the workpiece.
SRP Player Pro has a function to display back up board on its data. Therefore, you can create the data, simulating actual milling situation.
Description of CL (milling data) created by SRP Player Pro

What is a CL?
An abbreviation of Cutter Location. This means the track of the tool movement. One (1) CL is generated from one (1) profile.

The CL of SRP Player Pro starts from the tool initial position and repeats the milling in the order of approaching, cutting and escaping and finally returns to the tool initial position.

In the CL display, the track of the tool movement is displayed. Quick feed section is indicated by dotted lines whereas the cutting section by solid lines.

Diagram:
- Tool
- Cutting initial position
- Approaching section
- Cutting section
- Escaping section
- Model to be milled
Chapter 1

Outline

- Basic Operation
- Profile Description
- Profile Initial Value
- Common Items
- Optimization
- Edit Registered Data
Basic Operation
Chapter 2
SRP Player Pro basic training text

Basic Operation

Starting & ending of SRP Player Pro

◆ How to start
Following 4 methods are available for starting SRP Player Pro:

1. Double click the icon of SRP Player Pro.
2. Double click SPP file.
3. Drag SPP file on the icon.
4. From Windows start menu, select Program > SRP Player Pro > SRP Player Pro 1.0

◆ How to end
Following 2 methods are available for ending SRP Player Pro.

1. From file menu of SRP Player Pro, select “Exit”
2. Click “X” (close) located at upper right of the SRP Player Pro screen.
SRP Player Pro basic training text

Basic Operation

Screen and names of SRP Player Pro

◆Names of respective portion

- Menu bar & tool bar:
  Almost same commands are available on the menu bar and tool bar.

- Project tool bar:
  After preparing a new file, start the operation in the order from left icon. The icon is displayed in grey at the beginning. When
  you are proceeding with the operation in the order from left icon, the display of icons becomes active and the operation
  becomes possible.

- Project edit dialog:
  This dialog is automatically displayed when a project has been created.
Chapter 2

SRP Player Pro basic training text

Basic Operation

How to use a mouse on SRP Player Pro

◆ How to use a mouse

① Using left button, you can operate following functions:
  - Execution of a command from menu bar or icon
  - ON or OFF of a command
  - Selection of a graphic
  - Selection of an object using a frame. (Only on case that a whole graphic is located inside the frame.)
  * When you push the left button while holding down Ctrl, you can select a graphic even when only a part of that graphic has been contained.

② Using right button, you can operate following functions:
  - The command which starts by right button executes the items set on the icon.
  - If the view observing point is inclined while not in parallel to any X, Y or Z axis in the coordinate system, the view can be rotated by dragging the mouse with a right button.
  - When the view observing point is in parallel to X, Y and Z axes in the coordinate system, pan can be performed by dragging the mouse with a right button.
  - If you drag the mouse up or down with a right button while holding down Ctrl, you can execute expansion or shrinkage.

③ Using wheel button (center button), you can operate the following functions:
  - Dynamic zooming by rotating the wheel
SRP Player Pro basic training text

Basic Operation

Flow of data preparation by SRP Player Pro

0. Before start working:
   Check the setting of milling machine.
   (If the milling machine is not properly set, milling data that will maximize the milling machine performance cannot be created.)

1. New preparation:
   Read the model data and create SRP Player Pro file.
   In addition, create a work space folder (a folder to control the milling data).
   [Note] Confirm that the model file has been properly read.

2. Preparation of a new workpiece:
   Determine the size and position of a workpiece (material to be cut).

3. Preparation of a project:
   Determine the project name.
   Select the material.
   Select the milling direction and cut off range.
   Select the type of cutting process.
   Select the tool to be used for each process.

4. Execution of calculation:
   Generate a CL.

5. Display of cut results:
   Check the results through easy cut simulation.

   Before outputting the milling data to milling machine, make sure to check the CL display (Show CL Data).

6. Data output:
   Output the data to the milling machine.
Chapter 2
SRP Player Pro basic training text

Basic Operation

Preferences

◆ Machine Settings
① Click the item “Option” > “Preferences” in the menu bar.

② Open the dialog “Machine Settings” in the “SRP Player Pro Preferences” and select the modeling machine name to be used.

③ Perform “Apply” and close the dialog to finish.
Preparation of new SRP Player Pro data

◆ Preparation of new SPP file
Read the 3D model file (polygon model or surface model) and create a SRP Player Pro file (*.spp).

◆ Screen configuration of SRP Player Pro

Immediately after starting, the tool bar is displayed as above.
When preparing the data, milling processed with selecting the icons in the active display in the order from the left one.

-New file

File > New [Ctrl + N]

When this command has been selected, a wizard for new preparation will be displayed.

When preparing a file, a work space folder having the same name as the file name is created. Work space folder means a folder that control the milling data created by SRP Player Pro.
Chapter 2

- Designation of a model file

If you select “Next” after inputting the file name in the Model File field, a model file designated wizard will be displayed.

If you push the Browse button, a window to “Open” will be opened. Here, select the file location and designate the file according to the subject file type.

SRP Player Pro file being created newly, the preparation of a work space folder having the same name, file location and the designated model file name will be displayed. If the displayed conditions are correct, push “Finish”. If not correct, push “Back” to make change.
If you select “Finish” after confirming the conditions, the progress bar “Reading File now” will be displayed.

When the reading of a model file is complete, the model will be displayed with a wire frame.

Rotate or zoom up the read model file using a tool in the view tool bar to check for any missing surface data, etc.

* When the surface display is rough, change the setting of resolution to “Fine” on “View > Shading settings”.

Resolution:
Set the degree of polygon split for displaying shading
If you set fine, the display becomes smooth, whereas if you set rough, it becomes an angled display.

Reflection disturbance ratio (Shine):
Set the diffusion ratio of reflected light (shine)
If you set narrow, metallic texture is displayed, whereas if you set wide, soft texture is displayed.
Basic Operation

Layer function

Layer

Object > Layer

Display control, name change, preparation, migration and deletion are performed for imported graphic by each layer unit. Setting of layer will be controlled by each project unit.

* If any change is required to be made to the state of graphic subject to a deletion by carrying out change between display and non-display, migration or deletion, regeneration of CL becomes necessary for all profiles within the project.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Button</th>
<th>Brief Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="New Layer" /></td>
<td>New Layer</td>
<td>Creates layers in the order of [NewLayer1][NewLayer2]. To change the name of a layer, double-click the name or press F2 key after clicking the name.</td>
</tr>
<tr>
<td><img src="image" alt="Delete the selected layers" /></td>
<td>Delete the selected layers</td>
<td>Deletes the selected layers. Even if any layers are not selected, a warning message does not appear. You can not delete the current layer with this button.</td>
</tr>
<tr>
<td><img src="image" alt="Change to the selected layer" /></td>
<td>Change to the selected layer</td>
<td>Makes selected Objects belong to the selected layer. To confirm which layer an object belongs to, go to Geometry.</td>
</tr>
<tr>
<td><img src="image" alt="Display All" /></td>
<td>Display All</td>
<td>Display all objects.</td>
</tr>
<tr>
<td><img src="image" alt="Display only the current layer" /></td>
<td>Display only the current layer</td>
<td>Display objects in the current layer and hide other objects in other layers. It is invalid to hide the current layer.</td>
</tr>
<tr>
<td><img src="image" alt="Select all objects in the selected layers" /></td>
<td>Select all objects in the selected layers</td>
<td>Select all objects in the selected layers.</td>
</tr>
<tr>
<td><img src="image" alt="Cancel the selections in the selected layers" /></td>
<td>Cancel the selections in the selected layers</td>
<td>Cancel the selections in the selected layers.</td>
</tr>
</tbody>
</table>

To close

When closing a dialog, a check dialog will be disclosed.

*Yes*: Using the changed state, every checking of CL generation is released.

*No*: The changed content is not implemented and returns to the state before layer edit, after closing layer edit screen.

*Cancel*: After closing this message, returns to the layer edit screen.
Outline

Basic Operation

Chapter 2

SRP Player Pro basic training text

Basic Operation

Preparation of new workpiece

Preparation of new SPP file

Workpiece means a material to process the read model file. The size and position of the workpiece are defined in the SRP Player Pro file according to the actual material.

The display has been changed from the display immediately after the start of operation. When a model file has been read, the number of icons actively displayed increases. Milling processed with by selecting operational icons in the order from the left.

Workpiece

Workpiece > New

A workpiece is newly created. For the new workpiece, set its size and position.

If you select this command, a screen to enter the new workpiece will be displayed.

* When preparing and editing a workpiece, the size of a workpiece will be displayed by dotted yellow lines.
Chapter 2

**Workpiece name (Name)**
You can edit the workpiece name newly created.

**Defined workpiece (Name List)**
The workpiece name currently defined will be displayed.

**Workpiece configuration (Shape)**
This is a block diagram of the origin of positioned workpiece and workpiece.

**Model boundary (Model Bounding Box)**
Model boundary is a rectangular solid having the maximum X, Y and Z coordinates and minimum X, Y and Z coordinates of the read model as its opposite angle.

**Alignment Origin (O)**
The lower left position of a workpiece from model coordinate original point (the position X, Y and Z become the minimum) is displayed by a relative coordinate.

**Size (S)**
Workpiece size is displayed in inch.

**Margin (M)**
A margin relative to model boundary is entered.
At an initial setting, 0.3937 inch margin has been set in all directions of the model boundary.

**Fix Size (L)**
If you put a ✓ mark in the check box, you can fix to the specified workpiece size.
The workpiece size will not be changed even if you have changed the margin.

**Restore Default (D)**
The set/changed value returns to the default.
To change the margin:
For example, if you change the margin of Z maximum value from 0.3937 inch to 0.1575 inch, you can observe that the workpiece size displayed by dotted yellow lines is resized.

When the workpiece size has been fixed, click “OK” to finish the command to create a new workpiece. When a workpiece has been created, the icons displayed active change and icons you can handle increase.

**Workpiece edit:**

Workpiece > Edit
You can edit the name, position and size of existing workpiece. The size of a workpiece under edit is displayed by dotted yellow lines.

**Deletion of a workpiece:**

Workpiece > Delete
The current (presently selected) workpiece is deleted.
When the workpiece has been deleted, all of the projects, profiles and CL data generated within the workpiece will be deleted.
A new project (planning for milling) is created. When a workpiece has been created, the icons displayed active change and the icons you can handle increase.

When changing the milling direction, you need to create a separate project.

**Number of projects**

Depending on the shape of a model, the shape can be expressed by milling from one direction or from 2 directions. Also, there are such shapes not possible to be expressed unless the milling faces are added such as 3rd direction or 4th direction. In such a case, increase the number of milling directions and then cutout the shape.

**Example of a milling from one direction**

- Milling from 1 direction only against the model
  - Cutting by splitting a model in halves and placing side by side
  - Completion of a model by affixing together
•Milling from 2 directions

When the shape cannot be expressed by milling from 1 direction only, carry out milling from 2nd direction by reversing the workpiece after milling from one direction.

After splitting a model in halves, these halves were arranged so that they may be cut from 2 directions.

Completion of a model by assembling

•Milling from 3 or more directions

When the shape cannot be expressed by milling from 2 directions, add a milling process in the milling direction you want to add after completing the milling from 2 directions.
As shown in the above example, the reproduction will become possible if the milling direction is added one by one in order to express the shape. However, if you attempt to express all shapes from the start by cutting process, the set up for milling becomes difficult, which may cause a failure due to any confusion.

To begin with, create the data to capture the level of expression of model shape you can attain through 1 face milling.

According to the procedures of new project preparation wizard, let us make various types of setting of the project.

- Preparation of a project

```plaintext
Project > New
```

If you select this command, new preparation wizard will be displayed.
Selection of material

After setting the project name and selecting “Next”, a wizard for selection of material is displayed.

- Name of workpiece material
  Selected material name is displayed.

- Candidate for selectable material
  Material candidates created in the SRP Player Pro database are displayed. Select a material name from these candidates.

- Material information
  Technical information related to the selected material is displayed.

- Setting of initial values (Set of Initial Values)
  Conditions for cutting process are set. The milling conditions displayed in the material information are recommended.

- Selection of material suitable for the application.
  What types of “Material suitable for use” will be available? Example of the characteristics and application of such materials:

Case 1: Volume check/materials suitable for application requiring repeated trial and error.
Styrofoam:
This is a hard type foam material and excellent in compressibility and water-shading quality. Types with very fine foam and relatively rough foam are available. Features included that cutting easiness is excellent, beautiful edge can be cutout, and invisible cutting trace makes, milling accuracy allow rough and the milling time can be reduced. Although this material is not resistant against external impact and easy to be damaged, its cost is relatively low and most suitable for preparing huge models.

Chemical wood (Soft):
Chemical wood (chemical synthetic wood), which has been developed as typical material for a model substituting for wood material. This material is easy to be processed with minimum distortion and lighter than wax. The external appearance of the finish is visually attractive. It is harder than Styrofoam, but not resistant against external impact and easy to be damaged. The cut chips become like powder.
Chapter 2

Case 2: Materials suitable for secondary use of master model, etc

Modeling-wax:
This material is easy to be cut and subsequent milling is also easy, but easy to be damaged.
As used many in the lost wax casting, this material has such features that the material as it is
suitable for secondary use.
After cutting completed, you can melt this material to reuse.

Chemical wood (Hard):
This is a material developed exclusively for test cutting of a master model.
It is a plastic material made by extrusion molding of special compound mainly composed
of ABS resin and easy to be cut. Therefore, cutter mark hardly remains. The finish is visually
attractive also with gloss. It is suitable for storage for long period of time.
Plating and coating is also available.
Because the cut scraps are not like powder, cleaning after milling is easy.

Case 3: Materials suitable for use under the same condition as an actual product

ABS:
This material is used in wide variety for furniture, TV cabinets, toys, various types of household
appliances, etc. and has such features as light weight, high strength, abrasion resistance,
dimensional stability, etc.
This material is best suited when testing any product having moving parts and mating
portion.

Case 4: Materials suitable for use when transparency is required

[Acrlyic resin (Methacrylic resin)]:
The feature of acrylic resin which must be mentioned first is that it has best transparent nature
among all plastics. The degree of its ultraviolet transparency ratio is larger than normal glass.
The optical characteristic is most excellent among all plastics.
An other characteristic to be mentioned is excellent climate resistance.
Appearance, surface gloss and surface hardness are also excellent.
Depending on the performance of a modeling machine, desired transparency cannot be
attained.
In such a case, a job to polish the surface using compound will be additionally required after
cutting process.

Case 5: Material suitable for use when you want to deform a model after cutting

Modeling Clay (Industrial clay):
This clay becomes soft when heated and hardens at room temperature.
This is hard type oil based clay, suitable for making 3D model for industrial use, craft, interior,
etc.
By repeating dishing up and cutting, you can change the design to your full satisfaction.
This material is used for trial production in 1/1 size of automobiles, motorcycles, etc.
This material is also most suitable for reverse engineering, by dishing up the clay on the model
after cutting by a modeling machine, scanning the model modified manually and again
converting it into data, etc.
To determine the milling direction:
If you select “Next” after setting the material selection, a wizard to determine the milling direction will be displayed.

Milling direction:
Put a mark to the milling direction you want to cut by selecting from 6 candidates of direction. The face viewed from the selected direction becomes the upper face of a workpiece.

Cut off range:
Here, select whether to cut up to “1/2” or up to the lowest portion of the model shape.
For the setting of milling cut off range other than the candidates, you can make detailed edition later also.

Workpiece Coordinate (Effective only in case of G code output):
You designate in which workpiece coordinate system you should output when outputting NC code.
Select the workpiece coordinate from “0 (no designation), “G92” and “GS4 – GS9”.
Chapter 2

-Project origin

If you select "Next" after setting the milling direction, a wizard for a project origin will be displayed.

According to the workpiece size,
you can select the project point against the set workpiece from 3 layers of workpiece upper face (Top Plane), workpiece middle face (Middle Plane) and workpiece bottom face (Bottom Plane) and from 9 points on each face.

Based on the model origin,
if you put a check mark on the model origin, you can use the point on CAD for the project origin as it is.

-Profiles (Shape of cutting process )

If you select "Next" after setting the project origin, a wizard of the profile (shape of cutting process ) will be displayed.

The basic profile of SRP Player Pro is composed of 2 cutting process of Roughing (Z-level) and Finishing (Z-level). If you put a check mark on Finishing (Scanning-Line), the cutting pro becomes total 3 processes composed of 1 process for roughing and 2 processes for finish cut.

When "Generate Walls around workpiece" is checked, you can leave the workpiece without cutting thick wall, which is generated with SRP Player Pro.
Roughing Tool (Tool selection 1)

If you select "Next" after setting the shape of Roughing (Z-level), a wizard of tool selection 1 will be displayed.

Select a tool to be used for roughing (Z-level).
The milling conditions (rpm and feeding speed) will be determined by the combination of the nature of workpiece material and selected tool.

1. Tool to be used for roughing (Tools)
The tools which have been registered in the tool database are displayed as the candidates for use. From candidate tools, select the tool to be used for roughing.

2. Selected tool
Tool information of current selected tool is displayed.

3. Prior History Value
This is a parameter setting to be related to the combination of [Nature of workpiece material], [Tools] and [Milling mode]. If defined in the past using the parameter having the same conditions, give the first priority to that parameter value when using.

4. Tool list
When you select the set name from tool list if the tool set has been registered, you can also narrow the list down.

Roughing Tool (Tool selection 2)

If you select "Next" after setting tool selection 1, a wizard of tool selection 2 will be displayed.

Select the tool to be used for finishing (of Z-level/Scanning -Line).
The milling conditions (rpm and feeding speed) will be determined by the combination of the nature of workpiece material and selected tools.

◆ Tool you can select
The tool to be used by SRP Player Pro is an end-mill.
An end-mill is a tool which has flutes on its outside circumference and bottom face.
While rotating, it cuts the sides of the item to be processed using its outside circumference flute and cuts the upper face of the item using bottom flute.
Chapter 2

Description of each component of an end-mill

Length of flutes
It is important to select a tool having as shorter flute as possible according to the milling shape and milling depth of a workpiece. When the length of flutes is shorter, the tool can be set shorter to a modeling machine, resulting in a better milling accuracy.

Flute
In case of a tool having less flute, discharging of cut chips becomes easy, but the flute stiffness drops. If the flute is increased, the stiffness increases also, but cut chips easily get blocked because the width of groove becomes narrower.

Shank Len.
The portion no flute is present, namely the base portion is called as a shank. When setting the tool to a modeling machine, set this portion.

Types of end-mill
The tools which can be used for SRP Player Pro are those 3 types of “Flat end-mill”, “Ball End-mill” and “Radius end-mill”.

Flat (square) end-mill
The tool end point has a flat shape. It has a shape as if the drill end point has diminished. Not like a drill, it is a tool to cut in the horizontal direction while rotating and advancing using the side and bottom flute, instead of drilling ahead using its front end.

It is suitable for cutting a flat face and a ragged edge between profiles.
It cannot reproduce any gradually curved face or smoothly curved face. The finished shape after cut becomes like stairs. Because large amount of material can be cut off during a single pass, it is suitable for rough milling for removing unnecessary portions from the material. However, it has such a weak point that the finish allowance cannot be kept constant, because the uncut portions become like stairs.

Ball end-mill
The tool end point has a rounded shape. It is a tool to cut using the round shape flute.
It can reproduce smoothly curved face because all points of the hemispherical flute get in contact as if rolling a ball on a curved face. It is suitable for finish cut process.
Although the amount able to be cut during a single pass is not large, the flute resistance is small. It is suitable for halfway finish cut process where the finish allowance must be kept constant before roughing process/finish cut of hard material or such material difficult for milling.
The tool end point is flat and its corner has a round shape. It is a tool to cut using the flute at its side and bottom and the flute located on R portion. As you can understand from its profile, it is a tool having both features of a flat end-mill and a ball end-mill. The reproduction of smoothly curved surface sometimes becomes impossible due to the effect of bottom flute. The amount able to be cut during a single pass is large like a flat end-mill and the cut resistance is made smaller than that of a flat end-mill, thanks to the R portion. It is suitable for roughing as well as for halfway finish cut process before final finish cut process, because the finish cut allowance can be kept constant due to its R effect.

**Radius end-mill**

The cut cross-section has a shape having R at its every 4 corners. The corner becomes round and the bottom is flat up to the end of R. The amount of cut during a single pass is large.

No uncut portion is left if a pitch from the diameter to the corner R in the plane direction has been taken into consideration. The smoothly curved face is the same as the case of a ball tool.

**Flat (square) end-mill**

- Cut cross-section

The material is cut in a rectangular shape, giving right angle to the corner and flatness to the bottom. The amount of cut during a single pass is large.

- Portion left uncut

No uncut portion will be left, if the pitch in the plane direction is half of or less than the tool diameter. Uncut portion like stairs is left on the smoothly curved face.

**Ball end-mill**

- Cut cross-section

The cut cross-section becomes a hemispherical and the cut resistance is small. The amount of cut during a single pass is small.

- Portion left uncut

Uncut portion is left between R and R in the pitch for both plane direction and smoothly curved face.

Difference in the cut results depending on the tool used

The cut results of each tool are not the same because respective profile is not the same. Therefore, it is necessary for you to select the tool according to the purpose of milling. Select a tool giving your consideration to the advantages and disadvantages of the tools.

**Common Items**

- Edit Registered Data

Outline

Chapter 2

Basic Operation

Profile Description

Profile Initial Values

Common Items

Optimization

Edit Registered Data
Chapter 2

-To check the completion (Complete)

If you select "Next" after setting tool selection 2, a wizard to check the completion will be displayed.

Check the details of setting. A project is created with a shape designated as "Finish". If not correct, make correction from "Back".

When a project has been created, project editing dialog will be displayed on the screen left side, where you can carry out detailed edition.
SRP Player Pro basic training text

Basic Operation

CL generation

◆ CL calculation
After the creation of a project has been completed, a process path is to be calculated. Information required for the cutting process will be set while SRP Player Pro advances along the wizard format. Then a process path can be created by performing calculation only.

When a project has been created, the icons displayed active change and the number of icons you can handle increases.

- CL creation

CL Data > Generate CL Data > Current profile
CL of the current profile (one of the cutting process presently selected) can be generated. When CL generation has been completed, simulation calculation is carried out automatically.

- Creation of all CL of a project

CL Data > Generate CL Data > Current project
All CL of a profile in the current project can be generated. In the order of the profiles in the project, calculation is carried out for CL not yet generated. CL already generated is not recalculated. When CL generation has been completed, simulation is implemented automatically.
Chapter 2

When CL has been generated, all icons become active display and permit every operation.

- Simulation Result

CL Data > Simulation > Result

The simulation result is confirmed on the screen display.
Cannot be displayed when the simulation has not been completed

- Cutting Result

CL Data > Simulation > Cutting Result

The simulation result is displayed by overlapping it on the graphic in the active view window and the cut result is displayed.
Each time you push the button, the display of simulation result is turned ON and OFF.
Cannot be displayed when the simulation has not been completed
Only the combination of the button with shading command or wire frame command and the cut result can be displayed.

For setting the cut result display, you can do it through CL Data > Simulation > Cutting Result settings.
Select either one from “Normal”, “Translucent” or “Color identification of interference portion”.

Roughing (Wire & shading & translucent)

Finishing (Wire & shading & translucent)
Output NC Data

CL Data > Output NC Data

CL Data is output according to the milling machine selected by environment setting.
Cannot be displayed when no CL has been generated.

Point to output milling data

- Printer
  After preparing the milling data as a temporary file, the NC launcher of data output application is activated to transmit the data directly to output device.
  If you push "Execute (E)" after checking the file information, the data will be output.

- File
  Milling data is output as a file.
  If you push "OK" after setting and selecting each item, the milling data is created in the specified folder.

Creation and output of milling data can be performed through above procedures.
**CL Data Show Control**

The completed calculation result (Show CL Data) is displayed by each specified unit or segment. (Section from CL approach to Escape)

---

**Trace**
If you push start button, the points from the tool initial position and the tracks will be displayed in sequence.

**Coordinate value**
The instructed CL coordinate value is displayed. If you push reproduction button, CL from that point will be displayed in a trace.

**CL information**
The instructed CL information is displayed.

**Visible Section**
The display of approach or escape in the displayed section can be switched between ON and OFF.

**Interference**
The display of interference portion can be switched between ON and OFF.

**Segment**
A certain unit of height in case of contour is called as a segment and in other cases, the section between CL approach and escape is called as a segment.
Using this unit, the display can be switched between ON and OFF.
Profile Description
Chapter 3
SRP Player Pro basic training text
Profile Description

Types of profile

The types of profile explained in the basic lecture are following 5.
The height to be set is based on the height of tool front end.

Roughing (Z-level)
In roughing of contour, the tool rotates at a constant height against the milling shape and the cut off range is lowered in series.

Finishing (Z-level)
In Finishing (Z-level), the tool rotates at a constant height against the profile of milling shape and the cut off range is lowered. There is a “Contour offset path” function available that creates a path that automatically detects and processes any step which occurs when the contour interval is too wide.

Finishing (Scanning-Line)
A workpiece milling processed in roughing is processed to the final milling shape (allowance: 0) by scanning line (milling direction: constant). CL which becomes a linear line against the milling shape when viewed from above will be generated.

Curve Cutting
CL is generated based on the starting point and a cutting curve having a direction.
The finish cut allowance is adjusted in the height direction only.

Edge Cutting
By automatically detecting any concavity corner, a path for ragged edge milling by a flat end-mill is created.
Profile Menu

◆ Profile menu

Profile menu is a menu to create, edit and control the profiles.

- New
  A profile is to be created.
  In a dialog to create a new profile, the profile type and tools to be used are selected and the name of a profile to be created is set.
  In addition, you can select default setting of a profile.

- Edit
  Setting of a profile can be edited.

- Change Tool
  The tool in the current file can be changed.

- Cut Off Area
  The cut off area can be set.
  You can set multiple cut off areas in continuity in a single profile.
  Only current file becomes valid.
Roughing (Z-level)

A model shape milling processed from a workpiece is milling processed in a rough profile.

In roughing process, excessive thickness (finishing allowance) is to be left for the final cutting process.

Normal milling process starts from roughing of contour.

In roughing (Z-level) of contour, the tool rotates at a constant height against the milling shape and the cut off range is lowered in series.

The pitch the height lowers is kept at a constant height when vertical pitch height has been specified. When the projection length to be left uncut has been specified, the height of a portion without any shape lowers at same pitch and the portion with a shape lowers at an uneven pitch.

However, when no-cut of the flat portion has been specified, the height after the flat portion was milling processed will not be kept at the same pitch but at uneven pitch, even when the contour pitch has been specified as the height.
◆ Cut Off Range

This is a tab for setting the vertical (height) direction.

Uncut projection height (Cusp Height) (H)
Portion not to be cut can be set (Cusp Height). Depending on the shape, the pitch becomes uneven (Input impossible when flat tool has been specified).

Vertical pitch height (Step Down) (P)
Input the vertical direction pitch directly. The vertical pitch of CL generated becomes even pitch.

Cut Off Range
Starting and ending cut height can be set.
Chapter 3

Contour Property

This is a tab for setting additional process of plane direction and contour.

Step Over (Plane direction pitch) (P)

Pitches in CL plane direction can be set.

Allowance (Finish cut allowance) (A)

Finish cut allowance (excessive thickness to be left uncut) can be set.

Points to be noted for plane pitch

Give larger value than <0> to a pitch. The maximum value is limited by “Profile Initial Values”. Depending on the shape, some portion may be left uncut.
Path of Acute Angle Section (Milling of corner) (C)  * Open Corner milling.spp.

If you set a too large cutting pitch in the plane direction, uncut portion may be left partially at a sharp angle portion of CL.

If you switch the checkbox for Path of “Acute Angle Section” to ON, the presence of any uncut portion remaining at sharp angle portion will be searched. If there is a larger uncut portion than “uncut projection height” left at any angle portion, CL linking an angle to another angle will be generated.

In order to solve this problem, you can select 2 methods.

Cut Remainder(T)

Sharp edge portion is to be milling processed later. The shape of the portion left uncut at a plane pitch is to be removed.

Cut Corners First (R)

Process the sharp edge portion first. There is an effect that the load during milling of sharp edge can be reduced.
Chapter 3

Cutting Remaindered Flat Region (F)  * Open Cutting remaindered flat region.spp.

Uncut portion larger than the finishing allowance could be generated, depending on the shape when CL has been created at even pitch in the vertical direction.

- If you switch the checkbox for cutting remaindered flat region to ON, presence of any horizontal portion will be searched.

When there is any flat portion in the milling shape between the contour height pitches, CL that makes the finish cut of that portion constant will be generated.

In order to solve this problem, you can select 2 methods.

Remaining Flat Region (E) : After milling the contour, the flat portion on the way to the height of previous milling will be milling processed.

Entire Flat Region (B) : Before moving to the milling of next height in the contours, the flat portion in those contours will be milling processed.
◆ Cutting Pattern Approach

This is a tab for setting the offset method and approach method in the plane direction.

If you change the approach setting, the setting of escape will be also changed automatically to the setting of approach.

For cutting pattern, you can select either shape contour basis or workpiece edge basis, which will respectively become a combination with selective approach. Any approach not selectable will become grey-out.
Chapter 3

Shape Contour Basis  * Open Cutting pattern.spp (Shape contour basis).

The profile in the contour will be offset.
In case of convex shape, a path will be created along the shape offset profile to the workpiece area.

Depending on the shape, the amount of GOO movement becomes larger.

Shape Contour Basis Approach (M)
Approach method can be set.
If you change the approach setting, the setting of escape will be also changed automatically to the setting of approach.

Vertical
Approach will be made vertically. It becomes a shape in which approach 1 and 2 were overlapped.

Circular (Valid only when shape contour basis standard has been specified)
A 180° circular arc of the radius specified here to the workpiece will be added to plane approach. Therefore, the tool approach position will become a position separated from the workpiece by 2 times of radius size from the tool center.

Radius (R)
A circular arc radius of circular arc approach can be set.
Workpiece Edge Basis * Open Cutting pattern.spp(Workpiece edge basis)

In case of a convex shape, milling is performed through a path in which the workpiece edge has been offset until hitting the shape contour. Any portion left unmilling processed will be milling processed through a path in which the shape contour has been offset. In case of a concavity shape, a path in which the shape contour has been offset will be created.

The amount of the distance of GOO movement can be reduced because the path where any corner discontinues can be eliminated.

Workpiece Edge Basis Approach (W)

Vertical
Vertical approach is specified.

Tangential line (Valid only when workpiece edge basis has been specified)
For the position to start cutting of each offset contour, plane approach is performed in the length of specified tangent line. The tool approach position may become the position on the workpiece also, because the tool center is located at a distance from the start position of each offset contour.

Length (L)
The length of tangent line approach is set.
Chapter 3

Helical Approach (H)  * Open Helical approach.spp.

Helical approach is performed to a concavity shape.

Points to be noted for the angle of helical approach

If you perform helical approach, approach will take a long time. In order to process in safety, do not switch OFF the helical depth cut. It is recommendable to set the angle close to 90°.

Force Caving (F)  * Open Force caving.spp

If you put a ✓ mark in the checkbox, CL at which the tool moves only in the cut off area including the distances of approach and escape is generated same as the case a concavity shape is milling processed.

Points to be noted for Force Caving

If you use Force Caving, a milling path narrower than the normal cut off area will be created. If you want to create a milling path within the same cut off area as other modes, it is required to set by the tool movement range tab so that a path is created on the outside of normal position.
Details

Link-up milling method of CL which has been split according to cut off area or shape can be set.

Tool Path Around Wall  * Open Tool path around wall.spp.

The link-up method is to be specified when the Z-level contour is clipped by the workpiece edge or cutting range profile.

Along Plane (F)
Add approach and escape to the starting/ending positions, leaving the contour along the shape face.
Movement from ending position to the starting position of next contour is made according to the clearance height.

Round Plane Area (R)
When the contour has hit the workpiece edge or cut range contour, milling is carried out deeming that contour has been closed after transferring on to that Z-level.
Chapter 3

Cutting Concave Area  * Open Area.spp.

Milling method is to be specified when multiple cutting concave areas are present in the shape.
Z-level Fixed (H)
The territory is milling processed for each Z pitch.

Area Fixed (A)
Milling processed for each cutting concave area
Options

This is a tab for optimizing the precision setting/detail setting and created CL according to the purpose.

Precision Settings

Chordal Deviation (R)

Chordal deviation means a split precision of a curved face used when calculating the tool path.

If the chordal deviation is made small, the milling precision will be improved, but calculation takes time.

If it is made large, the calculation can be done quicker, but no tool path is sometimes created or a tool path is partially missing, because the milling shape cannot be captured correctly.

Tolerance of Curvature

The angle of vector variation in the advancing direction and the step precision (tolerance) can be specified, when moving the tool to the curved face subject to the milling in a step amount calculated according to the chordal deviation.

Judgement Angle (A) /Tolerance (S)

The tool path precision is determined by the combination of chordal deviation, curvature precision angle and step.

The tool path is calculated by getting the tool into contact with the curved face after moving it in a step amount calculated according to the chordal deviation.

If the position of the tool should be dislocated from the present advancing direction when calculating the next moving point, you should perform calculation in more details or set the angle for judgment at the curvature accuracy angle.

When the angle to the advancing direction is larger than this angle accuracy, perform more detailed calculation after calculating present position and the calculated halfway point of the moving point.

Set the minimum distance of this split using the step of curvature accuracy.

CL Reduction (L)

This is a permissible value to treat the data groups within specified range collectively as one block of single linear data (G01).

Details (D)

Detailed setting change that cannot be made in a normal setting becomes possible.
Chapter 3

◆ Tool Coverage (Concavity milling mode OFF)  * Open Tool coverage.spp.
To specify how far the tool can move in relation to the profile in the workpiece range or cut off area (CL in the cutting section)

Range of roughing path output
For roughing, a process path is created for whole workpiece in order to create a path to cutout a model from a workpiece.

Inside of Contour (I)
CL will be generated in the cutting section to prevent the whole tool from coming off from the cut off area profile.
Tool center on Contour (L)

CL will be generated in the cutting section up to the range the tool center transfers on to the cut off area profile.

Outside of Contour (U)

CL will be generated in the cutting section until the whole tool comes out of the cut off area profile.

Offset from Contour (O)

The range the tool center moves from the cut off area profile is directly specified numerically. CL will be generated in the cutting section where the tool center does not come out of the specified offset amount range.

Distance

Offset amount from the cut off area profile is set.
Chapter 3

◆ Tool Coverage (Concavity milling mode ON)

To specify how far the tool can move in relation to the profile in the workpiece range or cut off area (All of cutting section/approach/escape)

Concavity milling mode (F)

If you put a ✓ mark in the checkbox, CL at which the tool moves only within the cut off area, including the sections of approach and escape, same as the case a concavity shape is milling processed.

Inside of Contour – (Tool radius) (I)

All CL will be generated for the cut off area which is narrower than the inside of cut off area profile by tool radius.
Outline

Chapter 3

Basic Operation

Profile Description

Optimization

Profile Initial Values

Common Items

Edit Registered Data

Inside of tool Contour (L)

All CL will be generated for cut off area up to the cut off area profile.

Tool Center on Contour (U)

All CL will be generated for cut off areas up to the cut off area profile where the tool center is positioned.

Offset from Contour (O)

The range the tool center moves from cut off area profile is directly specified numerically.

All CL will be generated where the tool center does not come out of the specified offset range.

Distance

Offset amount from the cut off area profile is set.
Chapter 3

SRP Player Pro basic training text

Profile Description

Finishing (Z-level)

◆ Outline

Finish cut of contour

Finish cut is performed for the process shape which has become close to the final process shape to some extent through roughing process.

It is possible also to input the finish cut allowance and then perform halfway finish cut process.

In Finishing (Z-level), the tool rotates at a constant height against the milling shape and the cut off range is lowered in series.

When a model shape has been created by Z-level only, the shape of a face having a small slope sometimes becomes like stairs. In such a case, there is a function of “Z-level offset path” is available to create a path which automatically detects the portion where such step remains uncut and processes it.
◆ Cut Off Range

This is a tab for setting the vertical (height) direction.

Uncut projection height (Cusp Height) (H)

The uncut height (Cusp Height) can be set. Depending on the shape, the pitch becomes uneven. (Impossible to input when a flat tool has been specified)

Vertial pitch height (Step Down) (P)

The pitch in vertical direction is directly input. The vertical pitch of CL to be generated becomes even pitch.

Cut off Range

The starting and ending heights of cut height can be set.
Chapter 3

- **Z-level Property**  *Open Offset.spp.*

  This a tab for setting additional contour.

**Offset Cutting (F)**

A contour offset path (Offset Cutting) having a pitch specified by the calculation made on the flat face will be created by projection to the portion where the distance between contours (Z-level) becomes larger when viewed from the tool axis direction on the sloped surface.

Contour (Z-level) only

Contour (Z-level) + Offset path
Offset Base Contour (C)  * Open Offset path type.spp.

In case of a convex shape, the upper profile at each Z pitch is regarded as a profile to be offset, and in case of a concavity shape, the upper profile is regarded as a profile to be offset.

In case of a convex shape, after preparing a cutter path to which the upper side contour profile has been offset, the created path is projected on the milling face.

In case of a concavity shape, after preparing a cutter path to which the lower side contour profile has been offset, the created path is projected on the milling face.

Upper Contour (U)

The basis profile is always fixed on the upper profile, regardless of the convex or concavity shape.
Both Contour (R)

Regardless of convex or concavity shape, both of upper and lower sides contours should be offset.

XY Step Over (P)

Input the offset pitch of basis contour (YX cross-section of a shape created by the cutting pitch in Z direction)
Edge of Wall (E) * Open Edge of wall.spp

If you put a ✓ mark in the checkbox, you can set in such a manner the contour profile is output in case any standing wall shape should be present at the flat portion during offset cut.

When edge of wall check has been switched OFF

Because CL output at a contour pitch has been output to the position slightly above the bottom, uncut step occurs between offset paths.

When edge of wall check has been switched ON

When edge of wall has been output, no uncut portion appears because CL corresponding to the shape is output to the bottom height.

Points to be noted when outputting edge of wall

Because the path of edge of wall is forcibly output, calculation may not be done satisfactorily depending on the shape. In case of a shape having many ragged edges like polygon, the time required for calculation may become very long. In such a case, perform ragged Edge Cutting through Edge Cutting.
Chapter 3

Delete Tool Path from Flat Regions (Valid only when contour offset path has been switched OFF) (N)

* Open Output angle (contour).spp.

Delete Tool Path from Flat Regions

Setting is made so that no Z-level should be output to the flat face having smaller angle than specified. This is a function useful when carrying out finish milling of a flat portion in another process (scanning line finish, flat portion revolution, etc).

* This is valid only when a ball tool has been selected.

When the specified output angle has been input as “30°”, a path is created only at the position having an angle of “30°” or more.

An angle means an angle linking the contact point with a shape to the tool front end based on the center of ball tool R as its axis. Therefore, no angle limitation can be given to any flat tool.

Allowance (A)
◆ Approach/Connecting Move

This is a tab for setting the approach method and linkage movement method.

**Approach**

Specify the approach in the vertical direction or on a circle arc. Escape becomes an escape automatically linked to an approach.

**Vertical (V)**

Approach is made in a vertical direction.

**Circular (C)**

Approach is made while drawing a circular arc.

**Radius (R)**

Radius of circular arc approach can be set.

**Auto Adjustment (J)**

Adjustment is made in such a manner that the circular arc radius of the approach to be inserted when the circular arc approach has been specified does not interfere with a workpiece.

**Min. Radius**

The circular arc radius of approach is adjusted to its minimum radius.
Chapter 3

Tool Path Connecting Move * Open Tool path connecting move.spp.

The movement method from Z-level to Z-level can be set.
When the offset cutting set by a tab “Z-level Property” has been switched ON, you can select a method from the following 2 methods.

Not Perform (D)
Moves to the starting position of next contour through the clearance height

Approach: vertical
Approach: circular arc

Perform (E)
Moves by a linkage to the starting position of next Z-level

Approach: vertical
Approach: circular arc
When the offset cutting set by a tab “Z-level Property” has been switched OFF, you can select a method from the following 3 methods.

Not Perform (D)
Moves to the starting position of next contour through the clearance height

Perform (E)
Moves by a linkage to the starting position of next contour

Ramp on Face (S)
Moves by a linkage passing over the milling face to the starting position of next contour

When the “offset cutting” set by a tab “Z-level Property” has been switched ON, you cannot use this.
Details

* Open Tool path around wall 2.spp.

Linkage method of CL split depending on the cut off area or shape can be set.

Tool Path Around Wall

* Open Tool path around wall 2.spp.

The linkage method can be specified when the contour profile is clipped by a workpiece edge or cutting range contour.

Along Plane(F)

Leaving the Z-level along the shape face, approach and escape can be added to the starting and ending positions. The movement from an ending position to the starting position of next Z-level is performed at a clearance height.

Revolving (R)

When a Z-level has hit the workpiece edge or cutting range contour, milling is performed deeming the Z-level was closed after transferring on to the contour.
Cutting Concave Area * Open Area 2.spp.

Milling method can be specified when multiple cutting concave areas exist in a shape.

Z-level Fixed (H)
Area is milling processed at each Z pitch.

Area Fixed (A)
Milling processed for each cutting concave areas.
Finish cut path output range
Under the precondition that the finish cut is staying at a state roughing process has been done (a state excessive thickness of finish cut allowance is still remaining on the final shape), a finish cut path is created. Therefore, a path is created only on the surface of a model shape.

Inside of Contour (I)
CL is generated in the cutting section in such a manner the whole tool does not come out of cut off area contour.
Tool Center on Contour (L)
CL of cutting section is generated in a range the tool center is positioned on the cut off area contour.

Outside of Contour (U)
CL of cutting section is generated in a range the whole tool comes out of cut off area contour.

Offset from Contour (O)
The range the tool center moves from cut off area contour is directly specified numerically.
All CL will be generated where the tool center does not come out of the specified offset range.

Distance
Offset amount from the cut off area contour will be created.

In milling mode other than roughing process, in other words, when (subject model shape + tool diameter) is within a workpiece (within a cut off area), CL to be generated remains the same even when the tool movement range has been changed.

As shown in the sketch below, when a shape cannot fully enter the workpiece or when you do not want to output any approach or escape to outside of the workpiece (cut off area), change the tool movement range in a same manner as roughing and adjust the range where CL is to be generated.
In scanning line finish cut, a path will be created as if covering the model configuration at the specified pitch and specified running direction when the model configuration is viewed from above. In case of a curved face having a moderate slope in which you want to project a path parallel to the specified running direction to a model shape, the amount of excessive thickness becomes constant. Therefore, the load applied to a tool is also kept constant. Milling can be performed with less movement distance and within shorter time in approach or escape. However, in case of any model shape having a corrugated shape, variation in Z direction becomes large and the removal of excess thickness cannot be done at a constant rate. Therefore, depending on the position, there is a case milling load could be heavily applied.
◆ Property
This is a tab for setting a pitch in the vertical (height) direction/plane direction/finish cut allowance.

Cut Off Range

Pitch (Step Over)

Pitch distance
A pitch distance can be set directly at an even pitch.

Height left projection

Cusp Height
The height of uncut angle (Cusp Height) can be set.
It becomes as an uneven pitch depending on the shape. (Impossible to input when a flat tool has been specified)

Allowance (A)
Finish cut allowance can be set.
Chapter 3

◆ Traveling Type * Open Scanning line traveling type.spp.
This is a tab for setting a path creation method by scanning line.

Traveling Type
Path generation pattern can be set.

One-way (E)
A workpiece can be cut in a constant direction through a milling path parallel to the direction specified in the running direction.
When reaching the cut off area profile, the tool moves keeping a clearance height to the profile at starting side of next pitch. The cutting direction becomes “Down cut”.

Bi-directional (R)
A workpiece can be cut in a reciprocating movement through a path parallel to the direction specified in the running direction.
When reaching the cut off area profile, the tool moves over the profile to the next pitch.
The cutting direction becomes “Up and down cut”.

Tool Path Direction
The running direction in a path can be set. A path is created along X and Y axes in the project coordinate.
Reversal of running direction: The running direction in each X and Y axis can be reversed.

X-axis
CL will be generated in a direction parallel to X axis (in the project coordinate).

Y-axis
CL will be generated in a direction parallel to Y axis (in the project coordinate).
Angle (A)
Angle can be set in an anti-clockwise direction against the running direction in each X and Y axis. The angle you can specified is [- 180° Angle + 180°].

◆ Approach
This is a tab for setting an approach.

Approach (A)
You can set an approach in a vertical direction or by tangent line. Escape becomes automatically an escape linked to approach.

Vertical
Approach is performed in a vertical direction.

Tangential
A tangent line approach is performed in a specified length of tangent line.
Chapter 3

◆ Flat Regions

This is a tab for setting the method to create scanning line path.

By switching the checkbox to ON, you can set so that no scanning line is output to the standing wall having an angle exceeding the specified angle by flat regions judgment angle (Angle). This is helpful when performing finish cut milling of the standing wall in a separate process (contour milling).

Angle (A)
The area having an angle smaller than this angle is deemed as a flat region.
In order for this area to overlap the contour finish cut territory, set the output range angle larger than the output range angle specified by the contour output angle for contour finish cut.

Escape Allowance (E)
When any standing wall should exist in a shape, it may be rubbed during approach or escape. In such a case, a path performing approach/escape from a position apart from the standing wall [by escaping allowance] can be created.
Tool movement range

Tool movement range against a profile of workpiece range or cut off area can be specified. (CL in cutting sections)

Inside of Contour (I)
CL is generated in such a manner the whole tool does not come out of cut off area profile.

Tool Center on Contour (L)
CL is generated in a range the tool center is positioned on the cut off area profile.

Outside of Contour (U)
CL of cutting section is generated until the whole tool comes out of cut off area profile.

Offset from Contour
The range the tool center moves from cut off area profile is directly specified numerically.
CL will be generated where the tool center does not come out of the specified offset range.

Distance (O)
Offset amount from the cut off area profile can be created.
Chapter 3
SRP Player Pro basic training text

Profile Description

Edge Cutting

◆ Outline

Edge Cutting

Using a flat tool, detect any ragged edge.

By automatically detecting any ragged edge, create a cutter path for flat face.
◆ Allowance/approach * Open Edge.spp.
This is a tab for setting the finish cut allowance and approach.

Allowance (F)
Finishing allowance can be set.

Approach (A)
You can set approach vertically or in circular arc. Escape automatically becomes escape linked to approach.

**Vertical**
Approach can be made in vertical direction.

**Circular**
Approach is made like drawing a circular arc.

Radius (R)
Radius of circular arc approach can be set.
Chapter 3

◆ Step Down

This is a tab for setting the method of path creation in the height (drive in) direction.

Milling is started from a higher position by “Step Down” x “Repeat Count” and a path is created by the number of times of drive in.

Repeat Count (C)
Number of times of drive in Z direction can be specified.

Step Down (P)
Drive in pitch in Z direction can be specified.
◆ Tool Coverage

Tool coverage against a profile of workpiece range or cut off area can be specified. (CL in cutting sections)

Inside of Contour (I)
CL is generated in such a manner the whole tool does not come out of cut off area contour.

Tool center on Contour (L)
CL is generated in a range the tool center is positioned on the cut off area profile.

Outside of Contour (U)
CL of cutting section is generated until the whole tool comes out of cut off area contour.

Offset from Contour (O)
The range the tool center moves from cut off area contour is directly specified numerically. CL will be generated where the tool center does not come out of the specified offset contour.

Distance
Offset amount from the cut off area contour can be created.
Chapter 3
SRP Player Pro basic training text

Profile Description

Curve Cutting

◆ Outline

Curve Cutting

In curve cutting, CL will be generated based on a cutting curve having starting point and direction created according to the curve.

Different from other cutting modes, it is necessary to specify a subject cutting curve. It is possible to specify multiple cutting curves based on a single profile.

For CL generated by curve cutting, no check will be made for any interference of a model shape with polygon or curved face. CL will be generated based on a cutting curve.
What is curve cutting?
Milling is carried out using curves of the portion of a model shape not expressed by polygon or curved face.

The curves subject to milling should be created in advance (by CAD/CG software).
For CL generated by curve cutting, no check will be made for any interference of a model shape with polygon or curved face.
CL will be generated based on the cutting curve.

0. Before starting workpiece
Read the curves created (by CAD/CG software).

1. Creation of a workpiece and project

2. Creation of a profile for curve cutting
A profile of curve cutting is created.

3. Creation of cutting curve
“Cutting curve” is created.

4. Specification of cutting curve
Curve subject to cut is specified.

5. Decision of cutting curve
Cutting curve is fixed.

6. Execution of calculation
CL is generated.

7. Checking of shape
Result of simulation is checked.

Edition of cutting curve
Created cutting curve is edited for the orientation reverse of a curve, movement from starting point, etc.
Chapter 3

◆ Traveling Type  * Open Curve.spp.

This is a tab for setting a path route (traveling type).

![Traveling Type Diagram]

**Traveling Type**

**One-way (E)**

The cut direction is always in one way.

**Bi-directional (R)**

When 2 or more numbers of depth cut have been defined, the cut direction is changed for each cut off range. The final cut face follows the defined starting point and cut direction. (Round cut)
◆ Step Down
This is a tab for setting the path output range of curve cutting.

Top (T)
The height the curve cutting should start can be set. CL will be clipped so that this height is not exceeded.

Bottom (B)
This is the height when the curve cutting ends. CL less than this height will be clipped.

Repeat Count (C)
The number of times of depth cut can be specified within the cut off range.

Step Down (P)
A pitch of depth cut in Z direction can be specified. (Valid when specified to the number of times of depth cut only)

Allowance (A)
Finish cut allowance can be set. (Finish cut allowance is added to the height direction only.)
Chapter 3

Height difference in paths created by a tool used

A path is created along the cutting curve line to which tool center has been specified. Because the heights of the center of a ball tool and flat tool are not the same, the path heights to be created are not the same even when the subject cutting curve and tool diameter are the same.
Profile Initial Values
Profile Initial Values

About profile initial values

What is profile initial value?
This is an initial value of a set value in each milling mode. There are 2 types of initial values, one is a Default and the other is a Factor.

Default
This is an item automatically set when a profile has been created. When a Default is a numerical value, it is directly set numerically. When a Default is a letter, click the setting to be changed and select from the pull down menu.

Factor
This depends on the tool diameter or feed speed. A value obtained by multiplying each item by Factor is used as an initial value.

This change does not affect the profile already created.
The initial value set from a created profile is reflected after editing the profile initial value.

Set of Initial values
Initial value is controlled by “set of initial values” which has put all modes together, and not controlled by each mode of a profile. The profile initial value is segmented for each milling machine or by milling accuracy unit, etc and the user is set.

Limitation:
You cannot delete initial value set “Default”.

If you right-click on the initial value set screen, you can perform “New”, “Duplicate”, “Rename” or “Delete”.

Set of Initial Values

OK Cancel
### Roughing (Z-level)

#### Default:

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Depth of Cut</td>
<td>Step Down</td>
</tr>
<tr>
<td>Finishing Allowance</td>
<td>0.0190600</td>
</tr>
<tr>
<td>Cutting Pattern</td>
<td>Shape Contour Basis</td>
</tr>
<tr>
<td>Tool Path Around Wall</td>
<td>Along Plane</td>
</tr>
<tr>
<td>Cutting Concave Area</td>
<td>Area Fixed</td>
</tr>
<tr>
<td>Offsetting</td>
<td>Perform</td>
</tr>
<tr>
<td>Cutting Remainerd Flat Region</td>
<td>Remaining Flat Region</td>
</tr>
<tr>
<td>Path of Acute Angle Section</td>
<td>Not Perform</td>
</tr>
<tr>
<td>Number of Divisions</td>
<td>0</td>
</tr>
<tr>
<td>Step to Detect Cavity/Core Part</td>
<td>0.0190600</td>
</tr>
<tr>
<td>Tolerance for Reduction</td>
<td>0.00000394</td>
</tr>
<tr>
<td>Length of vertical Approach 1</td>
<td>0.00335370</td>
</tr>
<tr>
<td>IDS_CPL_SF_HELCAL_SINGLE_FLAG</td>
<td>Perform</td>
</tr>
<tr>
<td>Helical Angle</td>
<td>3.0000000</td>
</tr>
<tr>
<td>Ignore Min. Contour Length</td>
<td>Perform</td>
</tr>
<tr>
<td>Approach Type</td>
<td>Circular</td>
</tr>
<tr>
<td>Offset Distance (Tool Coverage)</td>
<td>0.0000000</td>
</tr>
<tr>
<td>Tool Coverage</td>
<td>Tool Center on Contour</td>
</tr>
<tr>
<td>Chordal Deviation</td>
<td>0.00007324</td>
</tr>
<tr>
<td>Judgement Angle (Tolerance of Curvature)</td>
<td>7.0000000</td>
</tr>
<tr>
<td>Tolerance (Tolerance of Curvature)</td>
<td>0.00007324</td>
</tr>
</tbody>
</table>

#### Factor:

<table>
<thead>
<tr>
<th>Name</th>
<th>Base</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Horizontal Pitch</td>
<td>Tool Diameter</td>
<td>0.5000000</td>
</tr>
<tr>
<td>Max Vertical Pitch</td>
<td>Tool Diameter</td>
<td>1.5000000</td>
</tr>
<tr>
<td>Step Down</td>
<td>Tool Diameter</td>
<td>0.2000000</td>
</tr>
<tr>
<td>Step Over</td>
<td>Tool Diameter</td>
<td>0.4000000</td>
</tr>
<tr>
<td>Rate of Helical Approach</td>
<td>Feed Rate</td>
<td>0.3000000</td>
</tr>
<tr>
<td>Min. Contour Length</td>
<td>Tool Diameter</td>
<td>1.0000000</td>
</tr>
<tr>
<td>Rate of Vertical Approach 1</td>
<td>Feed Rate</td>
<td>0.3000000</td>
</tr>
<tr>
<td>Length of Vertical Approach 2</td>
<td>Tool Diameter</td>
<td>0.5000000</td>
</tr>
<tr>
<td>Rate of Vertical Approach 2</td>
<td>Feed Rate</td>
<td>0.3000000</td>
</tr>
<tr>
<td>Radius of Circular Approach</td>
<td>Tool Diameter</td>
<td>0.5000000</td>
</tr>
<tr>
<td>Length of Tangential Approach</td>
<td>Tool Diameter</td>
<td>0.5000000</td>
</tr>
<tr>
<td>Rate of Circular / Tangential Approach</td>
<td>Feed Rate</td>
<td>1.0000000</td>
</tr>
<tr>
<td>Length of Vertical Escape</td>
<td>Tool Diameter</td>
<td>1.0000000</td>
</tr>
<tr>
<td>Rate of Vertical Escape</td>
<td>Feed Rate</td>
<td>1.0000000</td>
</tr>
<tr>
<td>Rate of Cutting Vertices of Corners First</td>
<td>Feed Rate</td>
<td>0.0000000</td>
</tr>
<tr>
<td>Rate of Cutting Remainder in Acute Angle Section</td>
<td>Feed Rate</td>
<td>1.0000000</td>
</tr>
<tr>
<td>Rate of Approaching Remaindered Flat Area</td>
<td>Feed Rate</td>
<td>1.0000000</td>
</tr>
</tbody>
</table>
◆ Profile initial value of roughing (Z-level)

This is an initial value of the set value in the roughing mode. There are 2 types of initial values, one is a Default and the other is a Factor.

Default

When a Default is numerical value, change it by setting a numerical value directly by double clicking the value to be changed.

When a Default is letter, click the setting to be changed and select from pull down menu.

<table>
<thead>
<tr>
<th>Name (Default)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offsetting</td>
<td>The method to calculate tool path can be specified. This method is only available when the milling subject is a curved face.</td>
</tr>
<tr>
<td>Number of Divisions</td>
<td>Number of splits of calculation to be used when “cut corners first” can be selected in the corner pre-milling. No need to change it in normal operation.</td>
</tr>
<tr>
<td>Step to Detect Cavity/Core Part</td>
<td>A step amount is to be set when checking the shape to determine whether the shape subject to milling is a cavity (concavity) or a core (convex).</td>
</tr>
<tr>
<td>Tolerance for Reduction</td>
<td>A range can be set for determining whether or not the direction is the same when performing reduction.</td>
</tr>
<tr>
<td>Length of Vertical Approach 1</td>
<td>The length of vertical approach 1 can be set.</td>
</tr>
<tr>
<td>Ignore Min. Contour Length</td>
<td>Whether or not the profile length should be judged during helical cut depth can be specified.</td>
</tr>
<tr>
<td>Chordal Deviation</td>
<td>Chordal deviation is a split accuracy of a curved face when calculating a tool path.</td>
</tr>
<tr>
<td>Judgement Angle (Tolerance of Curvature)</td>
<td>When the direction should come off from present direction during calculation of next moving point, the calculation should be made in further details or the angle subject to judgment is set by a judgement angle.</td>
</tr>
<tr>
<td>Tolerance (Tolerance of Curvature)</td>
<td>The minimum distance when splitting can be set through a step of curvature accuracy.</td>
</tr>
</tbody>
</table>

-Offsetting

Perform: After offsetting the curved face, obtain the cross point with Z-value of tool center and specify that cross-point as the tool position. Although the calculation of a tool path can be done quickly, the calculation can be easily affected by the accuracy of curved face.

Not Perform: After dropping a tool from straight above, calculate the point it hit the curved face and specify that point as the tool position. Although the calculation of a tool cannot be done quickly, the calculation cannot be easily affected by the accuracy of curved face.

-Number of Divisions

This is the number of splits used when cut corners first has been selected in the corner pre-milling. There is no need to change it in normal operation.

-Step to Detect Cavity/Core Part

You can set the amount of a step when checking the shape to determine whether the shape subject to milling is a cavity (concavity) or a core (convex). In case of a shape in which similar concavity shapes are seemingly lined-up, or in case location where no CL should be output and location where some CL output are present, change this numerical figure.
Chapter 4

-Tolerance for Reduction

You can set the range for determining whether or not the direction is the same when performing reduction.

If you set the reduction value larger, the determination whether or not the direction is the same becomes permissive and you can reduce the data volume because the number of halfway moving points is reduced. However, even when the track of a path has changed largely as a result of reduction, no interference check will be performed for the shape.

Value between 0.00004 and 0.00394 is a recommendable use range.

For example, there is CL information having 6 branching points before reduction.

In case the branching points from 1 to 5 are within a permissible range, when this CL information is passed through reduction milling and the permissible range in which reduction has been specified (reduction value cylinder);

Linear data milling is performed for 1 block by getting together the data groups (branching points of 1 through 5) within the permissible range.

As shown above, there is a case the path in a single section becomes long by reduction milling resulting in a rough path. Change the set value if necessary.

* Re-calculation becomes necessary for changing the reduction value.

-Ignore Min. Contour Length

Whether or not the contour length should be judged during helical depth cut can be specified.
Perform: Disregarding the specified minimum profile length, helical depth cut is always output.
Not Perform: helical depth cut smaller than the minimum profile length is not output.

-Chordal Deviation

This is a value for specifying the calculation accuracy in the tool advancing direction (XY directions).
For a path, calculate the step amount which should become the standard to keep the chordal deviation, assuming that the curvature of a curved face is R3.937.

The path to be created is linear data. Because convex shape is “cutout” and concavity shape is “left uncut”, adjust the amount of “cutout” and “left uncut” according to the length of linear step amount.
Relationship between “cutout” and “left uncut” according to the length of step amount

**Chordal deviation value and step amount**

For example, if chordal deviation is set at “0.0197” when a tool with a size of ψ 0.3937 inch is moving around R3.937 circular arc, the step amount will become 0.1748 inch.

**Chordal deviation value and milling accuracy**

The value set for chordal deviation is the value of angle height left uncut (cusp height) in the tool, supposing that a tool before movement and after movement is placed there. Step amount is calculated in such a manner this projection height left uncut is maintained. The amount of “cutout” and “left uncut”, occurring when the tool moved on the surface with that step amount, is the milling accuracy.

In the example (when a tool with a size of ψ 0.3937 inch is moving around R3.937 circular arc);

Chordal deviation “0.0197 inch”/Step amount: “0.1748 inch”/Milling accuracy: “0.0008 inch”
Chapter 4
Curvature accuracy

The step amount calculated according to chordal deviation is preconditioned that the curvature of the shape subject to milling has been kept constant. In case of any point where the curvature has been changed largely, the path also makes a rapid change on a single curved face.
When such a change should occur to the curvature, the step amount is changed up to the specified accuracy value, in order to prevent the accuracy from becoming low due to the change of vector.

- Judgement Angle (Tolerance of Curvature)
This is a permissible value of an angle of vector change in a path on a single curved face.

- Tolerance (Tolerance of Curvature)
The boundary length of step amount is to be specified to determine in what details the calculation should be made.

For example, when moving to the next step and if the angle difference \( A \) from the previous path track is larger than the "angle value" specified in the curvature accuracy;

Reduce the distance of step amount (L) to its half and change it so that the change of angle becomes smaller.

Even when the distance has been reduced to its half and if "angle A" is still larger than the specified value, further reduce the step amount (L) to its half and calculate so that the angle should fall within the "angle value".

When the step amount (L) has reached its boundary length after repeating the checks and calculation of above angle change, stop the calculation of angle change to determine the position of next step amount.
Chapter 4

Factor

Double click the value and change it by setting a numerical value directly

<table>
<thead>
<tr>
<th>Name (Factor)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Horizontal Pitch</td>
<td>Maximum pitch in the plane direction</td>
</tr>
<tr>
<td>Max Vertical Pitch</td>
<td>Maximum pitch height in the vertical direction</td>
</tr>
<tr>
<td>Step Down</td>
<td>A pitch for setting to the profile in the vertical direction can be set.</td>
</tr>
<tr>
<td>Step Over</td>
<td>A pitch for setting to the profile in the plane direction can be set.</td>
</tr>
<tr>
<td>Rate of Helical Approach</td>
<td>Feed speed during helical depth cut can be set.</td>
</tr>
<tr>
<td>Min. Contour Length</td>
<td>The minimum length of the profile during helical depth cut can be set.</td>
</tr>
<tr>
<td>Rate of Vertical Approach 1</td>
<td>The speed of vertical approach 1 can be set.</td>
</tr>
<tr>
<td>Length of Vertical Approach 2</td>
<td>The length of vertical approach 2 can be set.</td>
</tr>
<tr>
<td>Rate of Vertical Approach 2</td>
<td>The speed of vertical approach 2 can be set.</td>
</tr>
<tr>
<td>Radius of Circular Approach</td>
<td>The circular arc radius can be set when circular arc approach has been set.</td>
</tr>
<tr>
<td>Length of Tangential Approach</td>
<td>The approach length can be set when tangent line approach has been set.</td>
</tr>
<tr>
<td>Rate of Circular/Tangential Approach</td>
<td>The speed during circular arc approach or tangent line approach can be set.</td>
</tr>
<tr>
<td>Length of Vertical Escape</td>
<td>The length of vertical escape can be set.</td>
</tr>
<tr>
<td>Rate of Vertical Escape</td>
<td>The speed of vertical escape can be set.</td>
</tr>
<tr>
<td>Rate of Cutting Vertices of Corners First</td>
<td>The cut speed during corner pre-milling can be set.</td>
</tr>
<tr>
<td>Rate of Cutting Remainder in Acute Angle Section</td>
<td>The cut speed of the corner uncut portion milling can be set.</td>
</tr>
<tr>
<td>Rate of Approaching Remaindered Flat Area</td>
<td>The approach speed of the uncut flat portion milling can be set.</td>
</tr>
</tbody>
</table>

Reliance relationship

**Tool diameter x Factor**

- **Max Horizontal Pitch**
  - Factor \(0.5 \times 0.1969 = 0.0985\)
  - Factor \(1.5 \times 0.1969 = 0.2954\)
  - Factor \(0.2 \times 0.1969 = 0.0394\)
  - Factor \(0.4 \times 0.1969 = 0.0788\)
  - Factor \(2.0 \times 0.1969 = 0.3938\)

- **Max Vertical Pitch**
  - Factor \(0.5 \times 0.1969 = 0.0985\)

- **Step Down**
  - Factor \(0.4 \times 0.1969 = 0.0788\)

- **Step Over**
  - Factor \(0.5 \times 0.1969 = 0.0985\)
  - Factor \(0.5 \times 0.1969 = 0.0985\)

- **Min. Contour Length**
  - Factor \(2.0 \times 0.1969 = 0.3938\)

- **Length of Vertical Approach 2**
  - Factor \(0.5 \times 0.1969 = 0.0985\)

- **Radius of Circular Approach**
  - Factor \(0.5 \times 0.1969 = 0.0985\)

- **Length of Tangential Approach**
  - Factor \(0.5 \times 0.1969 = 0.0985\)

- **Rate of Vertical Approach**
  - Factor \(1.0 \times 0.1969 = 0.1969\)

**Feed rate x Factor**

- **Rate of Helical Approach**
  - Factor \(0.3 \times 800 \text{ mm/min} = 240 \text{ mm/min}\)

- **Rate of Vertical Approach 1**
  - Factor \(0.3 \times 800 \text{ mm/min} = 240 \text{ mm/min}\)

- **Length of Vertical Approach 2**
  - Factor \(0.3 \times 800 \text{ mm/min} = 240 \text{ mm/min}\)

- **Rate of Circular / Tangential Approach**
  - Factor \(1.0 \times 800 \text{ mm/min} = 800 \text{ mm/min}\)

- **Rate of Vertical Escape**
  - Factor \(0.6 \times 800 \text{ mm/min} = 480 \text{ mm/min}\)

- **Rate of Cutting Vertices of Corners First**
  - Factor \(1.0 \times 800 \text{ mm/min} = 800 \text{ mm/mm}\)

- **Rate of Cutting Remainder in Acute Angle Section**
  - Factor \(1.0 \times 800 \text{ mm/min} = 800 \text{ mm/mm}\)

- **Rate of Approaching Remaindered Flat Area**
  - Factor \(1.0 \times 800 \text{ mm/min} = 800 \text{ mm/mm}\)
Finishing (Z-level)

### Default

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Depth of Cut</td>
<td>Step Down</td>
</tr>
<tr>
<td>Finishing Allowance</td>
<td>0.0000000</td>
</tr>
<tr>
<td>Tool Path Around Wall</td>
<td>Along Plane</td>
</tr>
<tr>
<td>Cutting Concave Area</td>
<td>Area Feed</td>
</tr>
<tr>
<td>Offset Cutting</td>
<td>Perform</td>
</tr>
<tr>
<td>Offset Base Contour</td>
<td>Automatic</td>
</tr>
<tr>
<td>Edge of Wall</td>
<td>Not output</td>
</tr>
<tr>
<td>Offsetting</td>
<td>Perform</td>
</tr>
<tr>
<td>Step to Detect Cav. Core Port</td>
<td>0.0194850</td>
</tr>
<tr>
<td>Delete Tool Path from Flat Reg.</td>
<td>Perform</td>
</tr>
<tr>
<td>Angle to Judge Flat Region</td>
<td>0.0000000</td>
</tr>
<tr>
<td>Tolerance for Reduction</td>
<td>0.0000039</td>
</tr>
<tr>
<td>Tool Path Connecting Move</td>
<td>Not Perform</td>
</tr>
<tr>
<td>Length of Vertical Approach 1</td>
<td>0.0059070</td>
</tr>
<tr>
<td>Approach Type</td>
<td>Circular</td>
</tr>
<tr>
<td>Auto Adjustment of Circular Approach</td>
<td>Not Perform</td>
</tr>
<tr>
<td>Length of Helical Part (Z-level Finishing)</td>
<td>0.3337038</td>
</tr>
<tr>
<td>Offset Distance (Tool Coverage)</td>
<td>0.0000000</td>
</tr>
<tr>
<td>Tool Coverage</td>
<td>Tool Center on Contour</td>
</tr>
<tr>
<td>Chordal Deviation</td>
<td>0.0000000</td>
</tr>
<tr>
<td>Judgement Angle (Tolerance of Curvature)</td>
<td>5.0000000</td>
</tr>
<tr>
<td>Tolerance (Tolerance of Curvature)</td>
<td>0.0000000</td>
</tr>
<tr>
<td>Offset Cutting Limiting Angle</td>
<td>05.0000000</td>
</tr>
<tr>
<td>Offset Cutting Mode Limitation</td>
<td>Perform</td>
</tr>
</tbody>
</table>

### Factor

<table>
<thead>
<tr>
<th>Name</th>
<th>Base</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cusp Height</td>
<td>Tool Diameter</td>
<td>0.0000000</td>
</tr>
<tr>
<td>Max Offset Pitch</td>
<td>Tool Diameter</td>
<td>0.0000000</td>
</tr>
<tr>
<td>Max Vertical Pitch</td>
<td>Tool Diameter</td>
<td>1.0000000</td>
</tr>
<tr>
<td>Step Down</td>
<td>Tool Diameter</td>
<td>0.0000000</td>
</tr>
<tr>
<td>Safe Rate</td>
<td>Safe Rate</td>
<td>0.7000000</td>
</tr>
<tr>
<td>Cutting Rate in XY direction</td>
<td>Feed Rate</td>
<td>1.0000000</td>
</tr>
<tr>
<td>Cutting Rate of Connecting Move</td>
<td>Feed Rate</td>
<td>1.0000000</td>
</tr>
<tr>
<td>Min. Contour Length</td>
<td>Tool Diameter</td>
<td>0.0000000</td>
</tr>
<tr>
<td>Rate of Vertical Approach 1</td>
<td>Feed Rate</td>
<td>0.3000000</td>
</tr>
<tr>
<td>Length of Vertical Approach 2</td>
<td>Tool Diameter</td>
<td>0.5000000</td>
</tr>
<tr>
<td>Rate of Vertical Approach 2</td>
<td>Feed Rate</td>
<td>0.3000000</td>
</tr>
<tr>
<td>Rate of Circular Approach</td>
<td>Feed Rate</td>
<td>1.0000000</td>
</tr>
<tr>
<td>Radius of Circular Approach</td>
<td>Tool Diameter</td>
<td>0.5000000</td>
</tr>
<tr>
<td>Min. Radius of Circular Approach</td>
<td>Tool Diameter</td>
<td>0.1000000</td>
</tr>
<tr>
<td>Rate of Connecting Move in XY direction</td>
<td>Feed Rate</td>
<td>1.0000000</td>
</tr>
<tr>
<td>Rate of Connecting Move in Z direction</td>
<td>Feed Rate</td>
<td>0.3000000</td>
</tr>
<tr>
<td>Length of Vertical Escape</td>
<td>Tool Diameter</td>
<td>1.0000000</td>
</tr>
<tr>
<td>Rate of Vertical Escape</td>
<td>Feed Rate</td>
<td>1.0000000</td>
</tr>
<tr>
<td>Rate of Helical Approach</td>
<td>Feed Rate</td>
<td>0.0000000</td>
</tr>
</tbody>
</table>
◆ Profile initial values for contour finishing (Z-level)

This is an initial value of the set value in the contour finishing (Z-level) mode. There are 2 types of initial values, one is a Default and the other is a Factor.

Default

When a Default is a numerical value, change it by setting a numerical value directly by double clicking the value to be changed.

When a Default is a letter,
click the setting to be changed and select from pull down menu.

<table>
<thead>
<tr>
<th>Name (Default)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offsetting</td>
<td>The method to calculate tool path can be specified. This method is only available when the milling subject is a curved face.</td>
</tr>
<tr>
<td>Step to Detect Cavity/Core Part</td>
<td>A step amount is to be set when checking the shape to determine whether the shape subject to milling is a cavity (concavity) or a core (convex).</td>
</tr>
<tr>
<td>Tolerance for Reduction</td>
<td>The range can be set for determining whether or not the direction is the same when performing reduction</td>
</tr>
<tr>
<td>Length of Vertical Approach 1</td>
<td>The length of vertical approach 1 can be set.</td>
</tr>
<tr>
<td>Length of Helical Part (Z-level Finishing)</td>
<td>The length when the approach is for helical depth cut can be set.</td>
</tr>
<tr>
<td>Chordal Deviation</td>
<td>Chordal deviation is a split accuracy of a curved face when calculating a tool path.</td>
</tr>
<tr>
<td>Judgement Angle (Tolerance of Curvature)</td>
<td>When the direction should come off from present direction during calculation of next moving point, the calculation should be made in further details or the angle subject to judgment is set by a judgement angle.</td>
</tr>
<tr>
<td>Tolerance (Tolerance of Curvature)</td>
<td>The minimum distance when splitting is set by a step of curvature accuracy.</td>
</tr>
</tbody>
</table>

- Offsetting

Perform: After offsetting the curved face, obtain the cross point with Z-value of tool center and specify that cross-point as the tool position.

Although the calculation of a tool path can be done quickly, the calculation can be easily affected by the accuracy of curved face.

Not Perform: After dropping a tool from straight above, calculate the point it hit the curved face and specify that point as the tool position.

Although the calculation of a tool cannot be done quickly, the calculation cannot be easily affected by the accuracy of curved face.

- Step to Detect Cavity/Core Part

You can set the amount of a step when checking the shape to determine whether the shape subject to milling is a cavity (concavity) or a core (convex). In case of a shape in which similar concavity shapes are seemingly lined-up, or in case location where no CL should be output and location where some CL output are present, change this numerical figure.

- Length of helical part

When circular arc approach is unable to be made or in case of a movement on the face in the tangent line movement, it becomes helical depth cut. This value is used for the approach length. When you do not want an automatic helical depth cut, set to 0.0.
Chapter 4

Factor

Double click the value and change it by setting a numerical value directly.

<table>
<thead>
<tr>
<th>Name (Factor)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cusp height</td>
<td>This is used in a calculation by safety factor.</td>
</tr>
<tr>
<td>Max Offset Pitch</td>
<td>Maximum value of offset pitch in the contour offset path</td>
</tr>
<tr>
<td>Max Vertical Pitch</td>
<td>Maximum vertical pitch height</td>
</tr>
<tr>
<td>Step Down</td>
<td>A pitch in the vertical direction to be set to a profile can be set.</td>
</tr>
<tr>
<td>Step Over</td>
<td>An offset pitch of contour offset path to be set to a profile can be set.</td>
</tr>
<tr>
<td>Cutting Rate in XY Direction</td>
<td>The speed of contour offset path can be set.</td>
</tr>
<tr>
<td>Cutting Rate of Connecting Move</td>
<td>The speed during movement in linkage can be set.</td>
</tr>
<tr>
<td>Min. Contour Length</td>
<td>In case of an occurrence of a path shorter than the value specified here, that path will be deleted.</td>
</tr>
<tr>
<td>Rate of Vertical Approach 1</td>
<td>The speed of vertical approach 1 can be set.</td>
</tr>
<tr>
<td>Length of Vertical Approach 2</td>
<td>The length of vertical approach 2 can be set.</td>
</tr>
<tr>
<td>Rate of Vertical Approach 2</td>
<td>The speed of vertical approach 2 can be set.</td>
</tr>
<tr>
<td>Rate of Circular Approach</td>
<td>The circular arc radius can be set when circular approach has been set.</td>
</tr>
<tr>
<td>Radius of Circular Approach</td>
<td>The approach length can be set when tangent line approach has been set.</td>
</tr>
<tr>
<td>Min. Radius of Circular Approach</td>
<td>The minimum radius of circular arc approach can be set.</td>
</tr>
<tr>
<td>Rate of Connecting Move in XY Direction</td>
<td>The moving speed in XY plane directions during movement in linkage can be set.</td>
</tr>
<tr>
<td>Rate of Connecting Move in Z Direction</td>
<td>The moving speed in the vertical direction during movement in linkage can be set.</td>
</tr>
<tr>
<td>Length of Vertical Escape</td>
<td>The vertical escaping length can be set.</td>
</tr>
<tr>
<td>Rate of Vertical Escape</td>
<td>The vertical escaping speed can be set.</td>
</tr>
<tr>
<td>Rate of Helical Approach</td>
<td>Feed speed during helical depth cut can be set.</td>
</tr>
</tbody>
</table>

Reliance relationship

Safety rate x Factor

<table>
<thead>
<tr>
<th>Tool diameter x Factor</th>
<th>Example of set value (Tool diameter: 0.1181, Cusp height: 0.0001)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Offset Pitch</td>
<td>Factor “0.5” x ψ 0.1181 = Set value “0.0591”</td>
</tr>
<tr>
<td>Max Vertical Pitch</td>
<td>Factor “1.5” x ψ 0.1181 = Set value “0.1772”</td>
</tr>
<tr>
<td>Step Down</td>
<td>Factor “0.1” x ψ 0.1181 = Set value “0.0118”</td>
</tr>
<tr>
<td>Min. Contour Length</td>
<td>Factor “0.0” x ψ 0.1181 = Set value “0.0”</td>
</tr>
<tr>
<td>Length of Vertical Approach 2</td>
<td>Factor “0.5” x ψ 0.1181 = Set value “0.0591”</td>
</tr>
<tr>
<td>Circular arc approach radius</td>
<td>Factor “0.5” x ψ 0.1181 = Set value “0.0591”</td>
</tr>
<tr>
<td>Minimum radius of circular arc approach</td>
<td>Factor “0.1” x ψ 0.1181 = Set value “0.0118”</td>
</tr>
<tr>
<td>Vertical escaping length</td>
<td>Factor “1.0” x ψ 0.1181 = Set value “0.1181”</td>
</tr>
</tbody>
</table>

Feed rate x Factor

<table>
<thead>
<tr>
<th>Example of set value (Feed rate: 800 mm/min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut speed in the plane direction</td>
</tr>
<tr>
<td>Cut speed of linkage point</td>
</tr>
<tr>
<td>Vertical approach speed 1</td>
</tr>
<tr>
<td>Vertical approach speed 2</td>
</tr>
<tr>
<td>Rate of Circular Approach</td>
</tr>
<tr>
<td>Rate of Connecting Move in XY Direction</td>
</tr>
<tr>
<td>Rate of Connecting Move in Z Direction</td>
</tr>
<tr>
<td>Rate of Vertical Escape</td>
</tr>
<tr>
<td>Rate of Helical Approach</td>
</tr>
</tbody>
</table>
Profile Initial Values

Chapter 4

Finishing (Scanning-line)

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Depth of Cut</td>
<td>0.0000009</td>
</tr>
<tr>
<td>Finishing Allowance</td>
<td>0.000009</td>
</tr>
<tr>
<td>Tool Path Direction</td>
<td>X-axis</td>
</tr>
<tr>
<td>Relative Angle</td>
<td>0.0000009</td>
</tr>
<tr>
<td>Crop Height</td>
<td>0.000009</td>
</tr>
<tr>
<td>Traveling Type</td>
<td>Bi-directional</td>
</tr>
<tr>
<td>Offsetting</td>
<td>Performed</td>
</tr>
<tr>
<td>Judgement Angle for Shifting</td>
<td>0.000009</td>
</tr>
<tr>
<td>Tolerance for Shifting</td>
<td>0.000091</td>
</tr>
<tr>
<td>Tolerance for Rejection</td>
<td>0.000091</td>
</tr>
<tr>
<td>Length of Vertical Approach 1</td>
<td>0.0000009</td>
</tr>
<tr>
<td>Approach Type</td>
<td>Normal</td>
</tr>
<tr>
<td>Offset Distance (Tool Coverage)</td>
<td>0.0000009</td>
</tr>
<tr>
<td>Tool Coverage</td>
<td>Tool Center on Contour</td>
</tr>
<tr>
<td>Escape Allowance</td>
<td>0.000091</td>
</tr>
<tr>
<td>Angle to Detect Pass Region</td>
<td>06.0000009</td>
</tr>
<tr>
<td>Enter angle to generate Tool Path</td>
<td>Tool Form</td>
</tr>
<tr>
<td>Chordal Deviation</td>
<td>0.000091</td>
</tr>
<tr>
<td>Judgement Angle (Tolerance of Varying)</td>
<td>0.0000009</td>
</tr>
<tr>
<td>Tolerance (Tolerance of Varying)</td>
<td>0.000091</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Factor</th>
<th>Name</th>
<th>Rate</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crop Height</td>
<td></td>
<td>0.0000009</td>
<td></td>
</tr>
<tr>
<td>Max. Pitch Length</td>
<td></td>
<td>0.5000060</td>
<td></td>
</tr>
<tr>
<td>Step Over</td>
<td></td>
<td>Safe Rate</td>
<td>0.7000080</td>
</tr>
<tr>
<td>Rate of Vertical Approach 1</td>
<td></td>
<td>Fixed Rate</td>
<td>0.2000080</td>
</tr>
<tr>
<td>Length of Vertical Approach 1</td>
<td></td>
<td>Tool Diameter</td>
<td>0.0000000</td>
</tr>
<tr>
<td>Rate of Vertical Approach 2</td>
<td></td>
<td>Fixed Rate</td>
<td>0.2000080</td>
</tr>
<tr>
<td>Length of Tangential Approach</td>
<td></td>
<td>Tool Diameter</td>
<td>0.0000060</td>
</tr>
<tr>
<td>Rate of Tangential Approach</td>
<td></td>
<td>Fixed Rate</td>
<td>1.0000000</td>
</tr>
<tr>
<td>Length of Vertical Escape</td>
<td></td>
<td>Tool Diameter</td>
<td>0.0000000</td>
</tr>
<tr>
<td>Rate of Vertical Escape</td>
<td></td>
<td>Fixed Rate</td>
<td>1.0000000</td>
</tr>
</tbody>
</table>
Chapter 4

◆ Profile initial values of Finishing (Scanning-line)

This is an initial value of the set value in the contour finish cut mode. There are 2 types of initial values, one is a Default and the other is a Factor.

Default

When a Default is a numerical value, change it by setting a numerical value directly by double clicking the value to be changed.

When a Default is a letter,
click the setting to be changed and select from pull down menu.

<table>
<thead>
<tr>
<th>Name (Default)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offsetting</td>
<td>The method to calculate tool path can be specified. This method is only available when the milling subject is a curved face.</td>
</tr>
<tr>
<td>Judgement Angle for Shifting</td>
<td>When another curved face has become the subject from the curved face of which path is being calculated, a split angle can be set for calculating a milling path of the linkage point of a curved face and another curved face.</td>
</tr>
<tr>
<td>Tolerance for Shifting</td>
<td>A boundary length can be set for positioning the linkage point of a curved face with another curved face.</td>
</tr>
<tr>
<td>Tolerance for Reduction</td>
<td>The range can be set for determining whether or not the direction is the same when performing reduction.</td>
</tr>
<tr>
<td>Length of Vertical Approach 1</td>
<td>The length of vertical approach 1 can be set.</td>
</tr>
<tr>
<td>Chordal deviation</td>
<td>Chordal deviation is a split accuracy of a curved face when calculating a tool path.</td>
</tr>
<tr>
<td>Judgement Angle(Tolerance of Curvature)</td>
<td>When the direction should come off from present direction during calculation of next moving point, the calculation should be made in further details or the angle subject to judgment is set by an angle of curvature accuracy.</td>
</tr>
<tr>
<td>Tolerance (Tolerance of Curvature)</td>
<td>The minimum distance when splitting can be set by a step of curvature accuracy.</td>
</tr>
</tbody>
</table>

- Offsetting

Perform: After offsetting the curved face, obtain the cross point with Z-value of tool center and specify that cross-point as the tool position.

Although the calculation of a tool path can be done quickly, the calculation can be easily affected by the accuracy of curved face.

Not Perform: After dropping a tool from straight above, calculate the point it hit the curved face and specify that point as the tool position.

Although the calculation of a tool cannot be done quickly, the calculation cannot be easily affected by the accuracy of curved face.

- Judgement Angle for Shifting

When another curved face has become the subject from the curved face of which path is being calculated, a split angle can be set for calculating a milling path of the linkage point of a curved face and another curved face. Set this angle in a finest fashion so that the appearance of linked portion becomes fair.

- Tolerance for Shifting

A boundary length can be set for positioning the linkage point of a curved face with another curved face.
Chapter 4

Factor

Double click the value and change it by setting a numerical value directly.

<table>
<thead>
<tr>
<th>Name (Factor)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cusp Height</td>
<td>This is used in a calculation with safety factor.</td>
</tr>
<tr>
<td>Max Pitch Length</td>
<td>Maximum value of a pitch in the plane direction</td>
</tr>
<tr>
<td>Step Over</td>
<td>A pitch in the plane direction to be set to a profile can be set.</td>
</tr>
<tr>
<td>Rate of Vertical Approach 1</td>
<td>The speed of vertical approach 1 can be set.</td>
</tr>
<tr>
<td>Length of Vertical Approach 2</td>
<td>The speed of vertical approach 2 can be set.</td>
</tr>
<tr>
<td>Rate of Vertical Approach 2</td>
<td>The speed of vertical approach 2 can be set.</td>
</tr>
<tr>
<td>Length of Tangential Approach</td>
<td>The length of tangent line approach can be set.</td>
</tr>
<tr>
<td>Length of Vertical Escape</td>
<td>The length of vertical escape can be set.</td>
</tr>
<tr>
<td>Rate of Vertical Escape</td>
<td>The speed of vertical escape can be set.</td>
</tr>
</tbody>
</table>

Reliance relationship

Safety rate x Factor

Step Over

Example of set value (Tool diameter: 0.1181, Cusp height: 0.0001)
Numerical value obtained from uncut projection 0.002 x Safety factor 0.7 =
Set value “0.0043”

Example of set value (Tool diameter: 0.1181)
Factor “0.5” x ψ 0.1181 = Set value “0.0591”
Factor “0.5” x ψ 0.1181 = Set value “0.0591”
Factor “0.5” x ψ 0.1181 = Set value “0.0591”

Example of set value (Feed rate: 800 mm/min)
Factor “0.3” x 800 mm/min = Set value “240mm/min”
Factor “0.3” x 800 mm/min = Set value “240mm/min”
Factor “1.0” x 800 mm/min = Set value “800mm/min”
Factor “1.0” x 800 mm/min = Set value “800mm/min”
### Profile Initial Values

#### Edge Cutting

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finishing Allowance</td>
<td>0.000000</td>
</tr>
<tr>
<td>Offsetting</td>
<td>Perform</td>
</tr>
<tr>
<td>Repeat Count</td>
<td>2</td>
</tr>
<tr>
<td>Tolerance for Reduction</td>
<td>0.00000000</td>
</tr>
<tr>
<td>Edge Detection Angle</td>
<td>30.00000000</td>
</tr>
<tr>
<td>Edge Detection Gap volume</td>
<td>0.0078740</td>
</tr>
<tr>
<td>Judgement angle</td>
<td>Perform</td>
</tr>
<tr>
<td>Judgement angle value</td>
<td>5.0000000</td>
</tr>
<tr>
<td>Length of Vertical Approach 1</td>
<td>0.0039270</td>
</tr>
<tr>
<td>Approach Type</td>
<td>Circular</td>
</tr>
<tr>
<td>Tool Path Connecting Move</td>
<td>Not Perform</td>
</tr>
<tr>
<td>Offset Distance (Tool Coverage)</td>
<td>0.00000000</td>
</tr>
<tr>
<td>Tool Coverage</td>
<td>Tool Center on Contour</td>
</tr>
<tr>
<td>Cordal Deviation</td>
<td>0.0009307</td>
</tr>
<tr>
<td>Judgement Angle (Tolerance of Curvature)</td>
<td>5.0000000</td>
</tr>
<tr>
<td>Tolerance (Tolerance of Curvature)</td>
<td>0.0007874</td>
</tr>
</tbody>
</table>

#### Factor

<table>
<thead>
<tr>
<th>Name</th>
<th>Base</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Height depth of Cut</td>
<td>Tool Diameter</td>
<td>1.5000000</td>
</tr>
<tr>
<td>Spacing to Detect Ridgeline</td>
<td>Tool Diameter</td>
<td>0.2000000</td>
</tr>
<tr>
<td>Step Down</td>
<td>Tool Diameter</td>
<td>0.3000000</td>
</tr>
<tr>
<td>Rate of Vertical Approach 1</td>
<td>Feed Rate</td>
<td>0.3000000</td>
</tr>
<tr>
<td>Length of Vertical Approach 1</td>
<td>Tool Diameter</td>
<td>0.3000000</td>
</tr>
<tr>
<td>Rate of Vertical Approach 2</td>
<td>Feed Rate</td>
<td>0.3000000</td>
</tr>
<tr>
<td>Rate of Circular Approach</td>
<td>Feed Rate</td>
<td>1.0000000</td>
</tr>
<tr>
<td>Radius of Circular Approach</td>
<td>Tool Diameter</td>
<td>0.5000000</td>
</tr>
<tr>
<td>Min. Radius of Circular Approach</td>
<td>Tool Diameter</td>
<td>0.2000000</td>
</tr>
<tr>
<td>Approach Safety Distance</td>
<td>Tool Diameter</td>
<td>0.1000000</td>
</tr>
<tr>
<td>Rate of Connecting Move in X-Y Direction</td>
<td>Feed Rate</td>
<td>1.0000000</td>
</tr>
<tr>
<td>Rate of Connecting Move in Z Direction</td>
<td>Feed Rate</td>
<td>0.3000000</td>
</tr>
<tr>
<td>Length of Vertical Escape</td>
<td>Tool Diameter</td>
<td>1.0000000</td>
</tr>
<tr>
<td>Rate of Vertical Escape</td>
<td>Feed Rate</td>
<td>1.0000000</td>
</tr>
</tbody>
</table>
Profile initial values of edge cutting

This is an initial value of the set value in the Edge cutting mode. There are 2 types of initial values, one is a Default and the other is a Factor.

Default

When a Default is a numerical value, change it by setting a numerical value directly by double clicking the value to be changed.

When a Default is a letter,

click the setting to be changed and select from pull down menu.

<table>
<thead>
<tr>
<th>Name (Default)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offsetting</td>
<td>The method to calculate tool path can be specified. This method is only available when the milling subject is a curved face.</td>
</tr>
<tr>
<td>Tolerance for Reduction</td>
<td>The range can be set for determining whether or not the direction is the same when performing reduction.</td>
</tr>
<tr>
<td>Edge Detection Angle</td>
<td>The detection of a portion subject to the milling can be set by an angle and gap. After judging by an angle, a milling path will be output to the portion having the same step as the gap amount.</td>
</tr>
<tr>
<td>Edge Detection Gap volume</td>
<td></td>
</tr>
<tr>
<td>Judgement angle</td>
<td>This is a function to output the path only which is within the angle in the range specified by a milling path which has been created by edge detection angle and gap.</td>
</tr>
<tr>
<td>Judgement angle value</td>
<td>Judging angle can be set for use in the judgment of path output angle.</td>
</tr>
<tr>
<td>Length of Vertical Approach 1</td>
<td>Vertical approach length 1 can be set.</td>
</tr>
<tr>
<td>Chordal Deviation</td>
<td>Chordal deviation is a split accuracy of a curved face when calculating a tool path.</td>
</tr>
<tr>
<td>Judgement Angle(Tolerance of Curvature)</td>
<td>When the direction should come off from present direction during calculation of next moving point, the calculation should be made in further details or the angle subject to judgment is set by an angle of curvature accuracy.</td>
</tr>
<tr>
<td>Tolerance (Tolerance of Curvature)</td>
<td>The minimum distance when splitting is set by a step of curvature accuracy.</td>
</tr>
</tbody>
</table>

- Offsetting

Perform: After offsetting the curved face, obtain the cross point with Z-value of tool center and specify that cross-point as the tool position.

Although the calculation of a tool path can be done quickly, the calculation can be easily affected by the accuracy of curved face.

Not Perform: After dropping a tool from straight above, calculate the point it hit the curved face and specify that point as the tool position.

Although the calculation of a tool cannot be done quickly, the calculation cannot be easily affected by the accuracy of curved face.

- Edge Detection Angle/Edge Detection Gap volume

The detection of a portion subject to the milling can be set by an angle and gap. After judging by an angle, a milling path will be output to the portion having the same step as the gap amount.

If this angle is made too small, only a shape having a steep angle can be obtained, whereas if made large enough, the moderate shape portion will be recognized as a subject of milling.
Chapter 4

Edge detection

When the angle made by slope lines on the curved face which is separated by gap amount from the portion where the angle changes rapidly is larger than the edge detection angle, such a portion is determined as a subject of milling. A milling path is created by tracking that portion.

Judgement angle value

It is required that the angle from a horizontal portion is within the path output angle in order to create a path at the portion detected by detection angle.

When determined that the path output angle has been exceeded, no milling path will be output to that portion.

Edge Detection Gap volume

The step less than the edge detection gap volume cannot be detected.

If the edge detection gap amount has been set too large, there may be a portion to which no path is output.

If the edge detection gap volume has been set too small, a path may be output to the portion having no step due to calculation error.
Factor

Double click the value and change it by setting a numerical value directly.

<table>
<thead>
<tr>
<th>Name (Factor)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Height depth of Cut</td>
<td>Maximum value of height drive in pitch</td>
</tr>
<tr>
<td>Spacing to Detect Ridgeline</td>
<td>A distance to detect the edge line for preparing a path can be set from a shape.</td>
</tr>
<tr>
<td>Step Down</td>
<td>A distance to the next cutting section path can be set after the number of times of drive in has been set.</td>
</tr>
<tr>
<td>Rate of Vertical Approach 1</td>
<td>The speed of vertical approach 1 can be set.</td>
</tr>
<tr>
<td>Length of Vertical Approach 2</td>
<td>The length of vertical length 2 can be set.</td>
</tr>
<tr>
<td>Rate of Vertical Approach 2</td>
<td>The speed of vertical approach 2 can be set.</td>
</tr>
<tr>
<td>Rate of Circular Approach</td>
<td>The speed during circular arc approach can be set.</td>
</tr>
<tr>
<td>Radius of Circular Approach</td>
<td>The circular arc radius can be set when circular arc approach has been set.</td>
</tr>
<tr>
<td>Min. Radius of Circular Approach</td>
<td>The minimum radius of circular arc approach can be set.</td>
</tr>
<tr>
<td>Approach Safety Distance</td>
<td>A distance to prevent workpiece interference can be set from approach starting point to cut starting point.</td>
</tr>
<tr>
<td>Rate of Connecting Move in XY Direction</td>
<td>Moving speed in XY plane directions during movement in linkage can be set.</td>
</tr>
<tr>
<td>Rate of Connecting Move in Z Direction</td>
<td>Moving speed in the vertical direction during movement in linkage can be set.</td>
</tr>
<tr>
<td>Length of Vertical Escape</td>
<td>The length of vertical escape can be set.</td>
</tr>
<tr>
<td>Rate of Vertical Escape</td>
<td>The speed of vertical escape can be set.</td>
</tr>
</tbody>
</table>

Reliance relationship

**Tool diameter x Factor**

<table>
<thead>
<tr>
<th>Name</th>
<th>Example of set value (Tool diameter: 0.1181)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Height depth of Cut</td>
<td>Factor “0.5” x ψ 0.1181 = Set value “0.1772”</td>
</tr>
<tr>
<td>Spacing to Detect Ridgeline</td>
<td>Factor “0.2” x ψ 0.1181 = Set value “0.0236”</td>
</tr>
<tr>
<td>Step Down</td>
<td>Factor “0.3” x ψ 0.1181 = Set value “0.0354”</td>
</tr>
<tr>
<td>Length of Vertical Approach 2</td>
<td>Factor “0.5” x ψ0.1181= Set value “0.0591”</td>
</tr>
<tr>
<td>Radius of Circular Approach</td>
<td>Factor “0.5” x ψ0.1181= Set value “0.0591”</td>
</tr>
<tr>
<td>Min. Radius of Circular Approach</td>
<td>Factor “0.2” x ψ 0.1181 = Set value “0.0236”</td>
</tr>
<tr>
<td>Approach Safety Distance</td>
<td>Factor “0.1” x ψ 0.1181= Set value “0.0118”</td>
</tr>
<tr>
<td>Length of Vertical Escape</td>
<td>Factor “1.0” x ψ 0.1181 = Set value “0.1181”</td>
</tr>
</tbody>
</table>

**Feed rate x Factor**

<table>
<thead>
<tr>
<th>Name</th>
<th>Example of set value (Feed rate: 800 mm/min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rate of Vertical Approach 1</td>
<td>Factor “0.3” x 800 mm/min = Set value “240mm/min”</td>
</tr>
<tr>
<td>Rate of Vertical Approach 2</td>
<td>Factor “1.0” x 800 mm/min = Set value “800mm/min”</td>
</tr>
<tr>
<td>Rate of Circular Approach</td>
<td>Factor “1.0” x 800 mm/min = Set value “800mm/min”</td>
</tr>
<tr>
<td>Rate of Connecting Move in XY Direction</td>
<td>Factor “1.0” x 800 mm/min = Set value “800mm/min”</td>
</tr>
<tr>
<td>Rate of Connecting Move in Z Direction</td>
<td>Factor “0.3” x 800 mm/min = Set value “240mm/min”</td>
</tr>
<tr>
<td>Rate of Vertical Escape</td>
<td>Factor “1.0” x 800 mm/min = Set value “800mm/min”</td>
</tr>
</tbody>
</table>
Chapter 4
SRP Player Pro basic training text
Profile Initial Values

Curve Cutting

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finishing Allowance</td>
<td>0.00000000</td>
</tr>
<tr>
<td>Repeat Count</td>
<td>0</td>
</tr>
<tr>
<td>Tolerance</td>
<td>0.0003937</td>
</tr>
<tr>
<td>Length of Vertical Approach 1</td>
<td>0.0033570</td>
</tr>
<tr>
<td>Approach Type</td>
<td>Vertical</td>
</tr>
<tr>
<td>Traveling Type</td>
<td>One-way</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Factor</th>
<th>Name</th>
<th>Base</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max. Step Down</td>
<td>Tool Diameter</td>
<td>1.50000000</td>
<td></td>
</tr>
<tr>
<td>Step Down</td>
<td>Tool Diameter</td>
<td>0.00000000</td>
<td></td>
</tr>
<tr>
<td>Rate of Vertical Approach 1</td>
<td>Feed Rate</td>
<td>0.00000000</td>
<td></td>
</tr>
<tr>
<td>Length of Vertical Approach 2</td>
<td>Tool Diameter</td>
<td>0.00000000</td>
<td></td>
</tr>
<tr>
<td>Rate of Vertical Approach 2</td>
<td>Feed Rate</td>
<td>0.00000000</td>
<td></td>
</tr>
<tr>
<td>Length of Vertical Escape</td>
<td>Tool Diameter</td>
<td>0.50000000</td>
<td></td>
</tr>
<tr>
<td>Rate of Vertical Escape</td>
<td>Feed Rate</td>
<td>0.00000000</td>
<td></td>
</tr>
<tr>
<td>Rate of Di-directional Part</td>
<td>Feed Rate</td>
<td>0.00000000</td>
<td></td>
</tr>
</tbody>
</table>
Profile initial value of curve cutting

This is an initial value of the set value in the curve cutting mode. There are 2 types of initial values, one is a Default and the other is a Factor.

Default

When a Default is numerical value, change it by setting a numerical value directly by double clicking the value to be changed.

When a Default letter, click the setting to be changed and select from pull down menu.

<table>
<thead>
<tr>
<th>Name (Default)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tolerance</td>
<td>A permissible tolerance approximate to a curve can be set.</td>
</tr>
<tr>
<td>Length of Vertical Approach 1</td>
<td>The length of vertical approach 1 can be set.</td>
</tr>
</tbody>
</table>

Tolerance

A permissible tolerance approximate to a curve can be set. Calculate the maximum distance between a curve when preparing a tool path by approximating to the curve and the approximate straight line in such a manner that the result obtained becomes smaller than the value set here.

<table>
<thead>
<tr>
<th>Name (Coefficient)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max. Step Down</td>
<td>Maximum value of drive in pitch</td>
</tr>
<tr>
<td>Step Down</td>
<td>Depth cut amount in the vertical direction when number of times of depth cut has been specified</td>
</tr>
<tr>
<td>Rate of Vertical Approach 1</td>
<td>The speed of vertical approach 1 can be set.</td>
</tr>
<tr>
<td>Length of Vertical Approach 2</td>
<td>The length of vertical approach 2 can be set.</td>
</tr>
<tr>
<td>Rate of Vertical Approach 2</td>
<td>The speed of vertical approach 2 can be set.</td>
</tr>
<tr>
<td>Length of Vertical Escape</td>
<td>The length of vertical escape can be set.</td>
</tr>
<tr>
<td>Rate of Vertical Escape</td>
<td>The speed of vertical escape can be set.</td>
</tr>
<tr>
<td>Rate of Bi-directional Part</td>
<td>The speed of vertical depth cut during reciprocation can be set.</td>
</tr>
</tbody>
</table>
Common Items
Here, we will study the “Easy object editing function” installed on SRP Player Pro and method to limit the path output range in the plane direction, while preparing data for 2 faces milling using a remote control cover model.

STEP 1: Reading of model data
From the model folder in the desktop, read remote control cover .3dm into SRP Player Pro.

Use the file name as it is. A screen to check the storing place of SRP Player Pro file will appear.
STEP 2: Checking of model data

Layer function: Check the model data by performing shading display, etc

STEP 3: Setting of a workpiece

The size of the workpiece in this case has already been fixed as follows;
X: 3.2283 inch, Y: 2.0472 inch and Z: 0.3543 inch
Enter the above figures.

STEP 4: Setting of projects

You are going to create new projects.
In this case, milling will be performed from 2 directions.
2 projects are to be created also. If you change either project name, you will be able to identify it for easy control.
Chapter 5

STEP 5: Selection of material

Select “Chemical wood(Hard)” for the material.
For the profile initial value, select “Standard (resin family)” and click <Next>.

STEP 6: Determine the milling direction

For milling direction, select <+ Z>.
For the range of cut off range, select <Bottom>. Click <Next>.

STEP 7: Project origin

For project origin, select <Top Plane Center point>. Click <Next>.

STEP 8: Setting up of cut process

For cut process, select <Roughing (Z-level)/Finishing (Z-level)/Finishing (Scanning-Line). Put a ✔ mark to “Generate Wall around workpiece”. Enter “0.3937 inch” as a wall thickness.
Put a ✔ mark to “Taper”. Enter “1” as an angle and then click <Next>.
STEP 9: Selection of a tool 1 (for roughing)

For the tool to be used for roughing, select “Diameter 0.2362 inch/Radius 0 inch” and click <Next>.

STEP 10: Selection of a tool 2 (for finishing)

For the tool to be used for finishing, select “Diameter 0.1181 inch/Radius 0.0591 inch” and click <Next>.

STEP 11: Completion check

On the completion check screen, make a final check. If you find any error, click <Back>. If not, click <Finish>.

A project from + Z direction will be displayed.
Wall Property

STEP 12: Adjustment of property for wall setting

The wall thickness in Y direction is adjusted individually. Change the thickness of [Ymax] to “0.35433 inch” and [Ymin] to “0.35433 inch”. Press <OK> and close the edit dialog.

About Wall Setting

Create a wall, leaving the outer circumference uncut during milling. By preparing a wall, the reference face of a workpiece will remain as it is. Using this wall thickness, you can fix it by reversing when performing 2 faces milling.

Wall property

You can check the wall thickness presently being edited by dialog and the taper angle on the screen.

The wall will be displayed in the same color as the lines indicating the workpiece size. In case of shading display, the wall will be displayed in semi-transparent color.

During editing the wall property, the wall thickness and angle will be displayed on the screen by dotted yellow lines.
**Support Library**

**STEP 13: Workpiece of support object**

When you want to perform 2 faces milling, create a wall around the outer circumference profile of a workpiece and add a bridge (support) in order to link the wall to a model, as shown in the sketches below. This support will become necessary when cutting the next milling face after completion of the milling from 1st direction. Therefore, add the support object to remote control cover also.

Object > Support Library

Insert the registered object as a support shape. If you adjust using numerical figure(s) based on the object, you can check the size change on the model display screen. In addition, you can check the position and height to be arranged on the model display screen also.

1. **Object name**
   Select the object to be inserted. If you select it, an image will be displayed on the right window.

2. **L/W/H**
   Adjust the L (length), W (width) and H (height) of the object you selected.

3. **Position to insert a support**
   Specify the positions (+ X, - X, + Y, - Y) to arrange the support object viewing from X-Y position.

4. **Workpiece height**
   Using a slider, adjust the height to insert a support object.

5. **Moving amount from the center**
   Move the support object from the specified position by a finely selected amount of movement.

6. **Insert**
   Insert the support object you have set.
Chapter 5

- When inserting a support, the object will be divided by layer. Therefore, create a new layer to specify it as the current layer.

Because the layer has been changed, a checking message will be displayed. Click "Yes".

- Select a "Trapezoid" from "Object".
- Size of the object: L: 0.7480 inch/ H: 0.0787 inch, W: 0.1969 inch
- Select <X> for XY position.
- Keep "0 inch" distance unchanged from the center.
- For workpiece height, enter "- 0.1574 inch" which height will not interfere with the shape.

After checking the position on the screen, click <Insert>.

The support object will be displayed in a white wire frame during editing.

If you have completed the workpiece, the selected display changes to shading and you can confirm that the object has been inserted.
Without a break, insert a support into opposite side. Keep the numerical figures of support shape and workpiece height unchanged.

- Select <+ X> for XY position.

After checking the position on the screen, click <Insert>.

Without a break again, insert 2 supports from <+ Y> direction. Keep the numerical figures of support shape and workpiece height unchanged.

- Select <+ Y> for support workpiece position.

- Insert the moving distance from the center as “0.4331 inch” and “-0.4331 inch”.

After checking the position on the screen, click <Insert>.
Chapter 5
SRP Player Pro basic training text

Common Items

Edit Project

◆ Edit

Edit project dialog will be displayed on the screen left side. You can check the description of a project and edit it.

1. Surfacing data and Dowel pin holes data for this project can be created.

2. A list of the profile (milling process) of this project is shown.

3. The order of selected profiles can be changed using an arrow mark.

4. CL data show control dialog can be displayed.

5. The detailed information dialog of the project can be displayed.

6. The setting description of a profile can be displayed.

7. Tool diameter and tip radius can be displayed. The tool can be changed.

8. This is allowance. You can enter numerical figure directly to change it.

9. This is a cut off range of CL data. You can enter numerical figure directly to change it.

10. The milling conditions of current profile can be edited.
STEP 14: Each profile edit

- You are going to edit a roughing profile

Move the “Bottom” within the cut off range to the half height of support object.
If you click <Bottom>, the menu will be displayed.
Select “1/2” to specify either support object.

If you put a ✓ mark in the left checkbox of “Bottom”, the Bottom will be displayed.

- Without a break, you are going to edit a profile of scanning line.

Change the order so that you can perform finishing (scanning-line) after roughing milling.
If you select finishing (scanning-line) and click on the arrow mark, the order of finishing (scanning-line) and finishing (Z-level) will change.

Move the “Bottom” in the cut off range to the lowest portion of fillet shape.
Click <Bottom>. When a menu is displayed, select “Bottom” and then click the fillet shape.
Chapter 5

Without a break again, you are going to perform profile edit of contour finishing (Z-level).

Because it is not wanted to output any contour path to the portion already milling processed by scanning line, move the “Top” in the range of cut off range to 1/2 of fillet shape.

Click <Top>. When the menu is displayed, select “1/2” and then click fillet shape.

In order to change the Z-level offset path to OFF, display profile edit dialog.

Click the profile edit icon or the mark at the side of file name “Finishing (Z-level)”. 

Open Z-level Property tab and turn the checkbox of Offset Cutting to OFF.

Without a break again, set the cut off area in the plane direction of Finishing Offset Cutting
Cut off Area

◆ Setting the area in plane direction

It is possible to set multiple cut off areas in a single profile (Valid for current profile only). Cutting is performed in the order of specified ranges.

-Set cut off area

Profile > Cut off Area > New

Setting methods include curve instruction poly-line specification, rectangular specification and curved face specification. When the mouse icon display has changed on the screen, click the right-button to select the setting method from popup menu.

Cancel: To cancel the area specification
Curve instruction: This is a range instruction by closed curve. It is necessary to read the closed curve.
Poly-line specification: To specify directly the top point of poly-line using a mouse
Rectangular specification: A rectangular range specified by 2 points on the screen
Curved face specification: To specify a curved face within a range viewed from cut direction
Chapter 5

-In case of poly-line specification

1. Specify the point while clicking by a mouse as if to enclose a shape you want to process.

2. After enclosing the shape, right-click to display a menu and "Fix" it.

3. When fixed, lines in milling range color will be displayed. You can continue specifying the cut off area(s).

◆ Outside Area

Leaving the cut off area which has been set as it is, you are going to create the data for milling portions other than the cut off area.

When the cut off area has been set to outside area, the state of outside area in the toolbar becomes like being pushed.

You cannot specify the curved face in the cut off area under a setting of outside area.

When curved face has been specified to cut off area, you cannot select outside area in the toolbar.
After clicking the icon for setting cut off area, right-click to display a menu for specifying the cut off area. Select “Curve instruction”.

If you click by mouse cursor the profile outside of remote control shape, created and closed curve will be selected and set as a cut off area. (Layer name “Boundary”)

Display the profile edit dialog and open the Tool Coverage tab.

○ Select “Outside of Contour” and click “OK” to close the dialog.
Chapter 5

STEP 15: Calculation

Click "Generate all CL Data in Project" icon and perform calculation of all items within the project.

After completing the calculation, check the simulation results referring to CL.
CL generation from a remote host

When setting of remote host has been done, only the generated CL will be sent to CAM server.

This dialog is displayed at each CL generation when it has been set to “Select computer when generating CL data” in the setting of Option > Preferences > Remote host. In the remote host setting, setting to “Always local PC” or “Always remote Host” is possible, in which case this dialog will not be displayed.

Local

CL is generated on SRP Player Pro presently under execution.

Remote

Specify the CAM server PC to be used for remote CL generation.

When using CAM server on the same PC, select “localhost”.

Port No.

Specify the port No.

Match this No. with the port No. of CAM server PC to be used for CL generation.

CAM server

CAM server is a program which provides CL generation service upon request from SRP Player Pro through networkpiece.

What can be done by CAM server?

Because CL is generated on CAM server, operation/edit on SRP Player Pro becomes possible.

In addition, by preparing CL by another PC in the networkpiece, the operation can be done in a comfortable atmosphere without being affected by CPU load being generated during CL generation.

Operation environment of CAM server

CAM server functions as a service on Windows XP Vista.

TCP/IP protocol is used for the communication through networkpiece. Confirm that TCP/IP has been installed on both of the PC which uses SRP Player Pro and PC used for CAM server.

In order to operate CAM server, you will need dedicated hardware key for CAM server or hardware key for SRP Player Pro.
Chapter 5

◆ Simulation

● Display of result (CL data > Simulation > Result display)

Check the simulation result on the screen display. This will not be displayed if the simulation has not been completed yet.

Specify whether or not shading should be done. When not done, the wire display is appeared.

The workpiece is divided into 4 pieces and the cross-sectional shape is displayed. (For details, refer to the explanation below.)

Display the cross-sectional shape by "Section View".

X – Y
If you move the pointer, you can move the cross-section position at will. If you click the cross-section area, the cross-section will be displayed.

Position (P)
Specify the cross-section position by entering coordinate value.

[Supplement]
The calculation result is displayed with color-coding for each milling process.
(In the order of Magenta → Yellow → White → Magenta → Yellow → White → …)

Uncut portion can be checked.
Display in red color indicates an error portion. Recheck the parameter.
When the simulation display is too rough, adjust the optimizing mesh size.
Display of result (CL Data > Simulation > Cutting Result)

You are going to display the simulation result and cutting result by overlapping on the object displayed on the active view window. Each time you push the button, the simulation result display can be switched ON/OFF. This will not be displayed if the simulation has not been completed yet.

You can only display the result of combination of the button with shading command or wire frame command and the cutting result.

Setting of cutting result display can be performed by CL Data > Simulation > Cutting result setting.

Cutting Result Setting > Normal

The cutting result display can be set to normal display.

Cutting Result Setting > Translucent

The cutting result display can be set to translucent display.

Cutting Result Setting > Distinctive Interference

The cutting result display can be set to color-coded display of calculation result.
optimizing mesh size

The solid mesh size in the simulation (optimization) is edited by each project unit, by which the accuracy of a workpiece is determined.

Workpiece size
The length in the workpiece XY plane can be displayed. In addition, the number of meshes and its length after division can be displayed.

Mesh (M)
Specify the mesh size from 2 types of divide work and specify length.

Divide work
Division Number (D)
Divide the workpiece in the range of \(50 \leq \text{Division Number} \leq 2048\). Specify length

Specify Length (L)
Divide the workpiece in a specified length for X or Y, whichever is longer.

The number of divisions at a specified length should be within the range of divide work.

After changing the optimized mesh size, the following dialog will be displayed.

If you select “Yes”, simulation of all profiles within the project will be performed.
If you select “No”, nothing will be performed and the status of simulation completion of all profiles within the project will disappear.

Preference: At an initial setting of a project, the default of this mesh size can be set. Default will become 500 divisions. Same as the change screen, the range of default of the divisions will become \(50 \leq \text{Division Number} \leq 2048\).

The initial setting of a project for preference is performed by Option > Preference > Project.
Change Tool

◆ Change tool

The tool in the current profile can be changed.

Select the tool to be set from the tool list in the tool selection dialog.
It is possible to change the tool cut conditions (RPM, feed rate, maximum depth cut amount) of the present tool can be changed also on the tool selection dialog.

If you click the title section in the tool list, you can change the alignment of tools.
If you click “Dia.,” the tools will be changed and displayed in the order having larger diameter. If you click again, tools will be displayed in the order of smaller diameter.

When you have changed RPM or feed rate on the tool change dialog, the following message will be displayed.
(When you have changed to a tool having same shape, you can apply the conditions without performing recalculation.)

Yes
The parameter relating to speed will be changed.

No
Only RPM and feed rate will be changed.
Chapter 5
STEP 16: Creation of rear side project

If you click the icon of new project, a wizard of new project will start. Enter the project name as “REVERCE” and then click <Next>.

Select “Chemical wood (Hard)” for the material. For the profile initial value, select “Standard (resin)” and click <Next>.

Determine the milling direction
For milling direction, select <- Z>. For the range of cut off range, select <Bottom>. Click <Next>.

Project origin
For project origin, select <Top Plane - Center Point>. Click <Next>.

For cut process, select <Roughing (Z-level)/Finishing (Z-level)/Finishing (Scanning-Line)}. Put a ✓ mark to “Creation of wall around the workpiece”. Enter “0.3937 inch” as a wall thickness. Put a ✓ mark to “Taper”. Enter “1” as an angle and then click <Next>.
For the tool to be used for roughing, select “Diameter 0.0787 inch/Radius R 0 inch” and click <Next>.

For the tool to be used for finishing, select “Diameter 0.0394 inch/Radius R 0.0197 inch” and click <Next>.

On the Complete screen, make a final check. If you find any error, click <Back>. If not, click <Finish>.

The wall thickness in Y direction is adjusted individually. Change the thickness of [Ymax] to “0.35433 inch” and [Ymin] to “0.35433 inch”. Press <OK> and close the edit dialog.
When cutting from rear side, do not display the covered object, because you will want to cut a remote control cover with a hole drilled.

Open Menu > Object > Object Visibility

From display layer, point “lid” and make ready for selection by the white arrow below.

After selecting the lid, click an arrow mark heading for the non-display window, and register it to the object not to be displayed.

If you click <Apply>, the setting will be fixed.

For a profile to which object display has been set, the background color changes when being selected.

Layer object “lid” becomes non-display. The model shape subject to CL generation will become a remote control cover with a hole.
In the same way, set Object Visibility to Finishing (Z-level) also. After setting the cut off area, perform calculation.
Chapter 5
SRP Player Pro basic training text

Common Items

Project Template

◆ Template
Cutting pattern frequently used can be registered or called up.
After calling up a registered cutting pattern, it can be used for other models also.

Contents to be registered to template:
Each profile setting, wall setting and wall thickness, NC coordinate system, material
Contents that use the Profile Initial Values setting of an option:
Tool initial values X, Y and Z, clearance Z value, milling origin, milling direction, cut off range, optimized mesh, back-up board.

When registering template;
When a project has been completed, it can be registered.

If you click “Register”, a dialog for inputting the memo contents to be registered as template will be displayed.

When using registered template;
If a model has been read and a workpiece has been created, it becomes possible to use the template.

If you click “Create project”, a dialog “A new project can be created based on the selected template information” will be displayed.
If you click “Yes”, the project will be created.
When you want to start the registered template from new project creation wizard, put a ✔ mark in the checkbox “Use template” and click “Next” button.

Template dialog will be displayed.
Select the template you want to apply and then click “Create project”.

Select Material dialog will be displayed.
Select the material you want to use and then click “OK” button. (The milling conditions (RPM, feed rate) under a combination of the tool and material registered on the template will be reset.)

A dialog “Create new project” will be displayed.
If you click “Yes”, the project will be created.
Chapter 5

◆ Surfacing

The upper face of a workpiece can be cut flat.

This is a special function to process a flat face using a square (flat) end-mill, when the dimension of an actual workpiece upper face is different from that of workpiece shape defined on SRP Player Pro.

1. Click the surfacing icon located in the project edit dialog.

2. A message prompting you to select a tool for surfacing will be displayed. If you click “OK”, a screen to select a tool will be displayed.

3. Select a surfacing tool “ψ 0.2632 inch flat tool”.

4. Surfacing setting screen will be displayed. Enter the numerical figure of the item requiring any change.
Area in the plane direction

- Measurement of longitudinal (Y) direction
  Example: 64 mm

- Measurement of horizontal (X) direction
  Example: 98 mm

Cut amount in Z direction

The surfacing amount (the cut height when cutting from the highest point heading for lower direction) varies depending on the material to be surfaced.

The planing result will not become flat, if the material has not been cut completely from its highest point to its lowest point. Check the surfacing amount according to each material to be used.

In case of a flat material

In case of a material having a lower center portion

In case of a material having a lower portion at either side
Chapter 5

◆ Editing Surfacing dialog

Enter surfacing amount. Enter the amount of cutting height.

Enter a numerical figure with plane area (X/Y) + 0.0786 inch added.
X: Measured value + 0.0786 inch
Y: Measured value + 0.0786 inch
* The purpose is to figure the size larger by each 0.0393 inch than the outside of the material subject to cut.

Enter the numerical figure and check the cut off area from "Preview".

When the setting of surfacing has been completed and if you click "OK" to fix it, Output Milling Data screen will appear.
Positioning Pin hole

Drill a hole to insert a positioning pin through the workpiece and back-up board, in order to make it possible to match the positions without difficulty before and after reversing the workpiece when performing both sides milling.

-Dowel Pin Hole

CL data > Dowel Pin Holes

You can drill a hole to insert a positioning pin for use during both sides milling. For this positioning hole, specify an optional drilling specification using a single type tool.

Execution of Dowel Pin Holes

When using the dowel pin holes command for the first time, the following message box will be displayed.

Click “OK” to move to select Tool.

Select a tool to use for drilling a hole. 1.5 times of tool diameter is the minimum diameter of a hole. For a tool, you can select ball end-mill only.
Chapter 5

◆ Setting of positioning pin hole information

When you have selected a tool, the tool conditions and define hole.

As milling conditions, use a default and change to Define Hole tab and then input the information of a hole you want to drill.

Hole position
Set the diameter, position and depth of the hole you want to drill.
Set the position according to the hole diameter and depth of a hole to be drilled and also according to XY coordinate value in the project coordinate system.
Define by clicking “Add (A)” button.
In addition, the hole you want to add can be edited also.
If you double-click the item you want to edit or you push F2 key after selecting an item, you can enter the numeral figure directly.

◆ Setting of Dowel Pin Holes information

If you click “Output NC Data”, data output screen will appear.

* The diameter of finished positioning hole varies depending on the milling conditions and/or modeling machine.

After drilling a hole, confirm that the pin concerned can be inserted without any trouble.

After entering the numerical figure and if you click “Add” button, the hole position and depth which has been set during hole drilling will be displayed in a wire frame object.

* For checking the result of drilling, you can display it by .

If you click “Generate CL”, CL generated will be displayed.

* For checking the result of drilling, you can display it by .
Virtual Parting Plane

Except for curve cutting, you are going to create CL data as if a flat face is present at finished Z height.

If you put a ✅ mark in the checkbox, virtual parting plane becomes effective.

For finishing (Z-level) in general, cut milling will be performed for model shape only. By setting parting plane, the flat face can be finishing, assuming that a flat face is present at the Bottom within the cut off range.
Chapter 6
SRP Player Pro basic training text

Optimization

Optimizing CL Data

Optimizing CL Data
This is a function to create a most suitable path for cutting the generated CL data.
Here, elimination of air cut and optimize auto clearance will be explained.

When simulation has been completed, optimization set by the optional dialog within profile edit will be carried out. When
simulation has not been completed yet, CL generated but not optimized yet will be displayed

Optimizing CL Data
- Elimination of Air Cut
- Optimize Auto Clearance

When simulation has been completed, optimization set by the optional dialog within profile edit will be carried out. When
simulation has not been completed yet, CL generated but not optimized yet will be displayed.
**Elimination of Air cut / Automatic clearance**

◆ Elimination of Air cut

This is a function to delete CL data which is applied to air cut of a workpiece shape. If no process is present immediately before, there is no effect of this function.

![Diagram of Elimination of Air cut](image)

Elimination of Air cut

Elimination of Air cut (I)

If you put a ✓ mark, detailed setting input becomes possible.

G 01 division length (G)

A path with long G 01 can be divided into specified length and the presence of air cut portion in that divided path can be verified.

By this, any path not cut will be deleted.

Maximum length of a air cut (M)

G 01 length of cutter path data not deleting air cut can be specified.

No elimination of air cut will be done within the range of this length.

When the path length of air cut portion is larger than the set length, it rises up to clearance Z.

![Diagram of G 01 division length](image)

When the section (A) to delete air cut is short, increase of cut distance to which approach/escape should be added can be considered as shown in the sketch left.

For the section shorter than the value specified by [Maximum length of a path not cut], no elimination of air cut will be done in this section.
Chapter 6

Approach safety distance (A)
A safety distance can be specified in order to avoid a workpiece from being positioned at a ragged edge of a standing wall in all approach/escape positions for preventing any interference with the workpiece.

When the tool which has been set apart by a safety distance should come into an interference check area, determine the position by escaping in the safe direction by mesh width. Search for a point without interference from 8 candidate points.

◆Auto Clearance

Auto Clearance (O)
If you put a ✓ mark, detailed setting input becomes possible.

Safety-Z (Z)
The clearance height can be adjusted so that any interference with a workpiece may be avoided, assuming that a tool is located at a farther distance than actual in Z direction.

Safety-XY (X)
The clearance height can be adjusted so that any interference with a workpiece may be avoided, assuming that a tool is located at farther distance than actual in XY direction.

Vertical Approach 1 (1)
Specify Vertical Approach 1. If set to 0.0, the vertical approach length 1 will be deleted.

Vertical Approach 2 (2)
Specify vertical approach 2. If set to 0.0, the vertical approach length 2 will be deleted.

Vertical Approach
This becomes the total of 1 and 2. During auto clearance, this length is given first priority before Z safety distance. This is the same as vertical escape.

* When vertical approach 1 and 2 has been set to 0.0, vertical approach/escape disappears.
Edit Registered Data
Chapter 7
SRP Player Pro basic training text

Edit Registered Data

Edit Registered Data

◆ Edit Registered Data
Tool used for milling, material to be cut, milling conditions and workpiece size can be registered, edited or deleted.

The tool or material not registered cannot be used for SRP Player Pro. When any tool or material not set at the time of delivery should be used, or when changing the initial value of milling conditions (RPM, feed rate), do so using this edit registered data edit.

When editing, if you double-click the item in the list you want to edit or push F2 key after selecting that item, you can set directly by numerical figure. For fixing the edit, push Enter key or Tab key.

Tool Type
Tool manufacturer and tool type can be registered.

Tool
Registration can be made according to respective tool manufacturer and tool type.

Material/milling conditions
On SRP Player Pro, such milling conditions as the feed speed and RPM is calculated and determined according to the combination of the material and tool concerned. The basic factors for this calculation are "feed rate" and "feed per flute" which will be set to each tool type to be used for the subject material.

Workpiece Size
Prescribed size can be registered.
Tool Type

Tool type

Tool manufacturer and tool type can be registered or deleted.

How to register a new tool manufacturer

New Manufacturer...

If you click “New Manufacturer (M)”, the following dialog will appear.

New Tool Manufacturer

Input the manufacturer’s name to be added in the input field and then click “Add” button. The manufacturer’s name will be added in the tool type list.

New Tool Type...

If you click “New Tool Type (N)”, an input dialog for adding the tool type/model will appear.

Select a manufacturer’s name from pull down menu and input the tool type/model and basic data. If you click “Add”, the tool type will be added in the tool type list.
Edit Registered Data

Tool

Manufacturer and the tool according to tool type can be registered.

How to register a new tool

Select the manufacturer's name or tool name (tool type) to be added.

If you click “Add (A)” button, the following dialog will appear

After inputting information in each field and if you click “Add” button, the tool will be added in the list as a registered tool.

In case any discrepancy should be found with the shape when inputting numerical figure, an error message will be displayed.

How to edit the registered tool

If you double-click the tool column you want to edit, a dialog for tool edit will appear. After inputting information in each field and if you click “OK” button, the tool information will be reflected on the description you edited. In case any discrepancy should be found with the shape when inputting numerical figure, an error message will be displayed.
How to register a tool set

For a tool set, you can create in advance a tool list (by narrowing down the candidates) when selecting a tool list, or a combination of the tool name and tool number which become necessary during ATC output.

If you click “Edit Tool Set (T)” button, the following dialog will appear.

If you click “Add (A)” button, a dialog of “New Tool Set” will be displayed. Enter the set name.

Select a tool you want to use from a tool list and edit the tool set using arrows.

When you want to change the tool number, length correction number or diameter correction number, left-click items T, H and D and select the number from pull down menu.

Tool name: Tool name selected from “Tool list” will be displayed.
Diameter: Tool diameter selected from “Tool list” will be displayed.
Radius: Rad. selected from “Tool list” will be displayed.
T: Tool number can be set.
H: Length correction number can be set.
D: Diameter correction number can be set.
Material/Milling Conditions

◆ Material/milling conditions
Material and milling conditions such as tool and material can be registered.

![Material/Milling Conditions dialog box]

How to register new material
If you click "Add (A)" button, the following dialog will appear.

![New Material dialog box]

How to register milling conditions
Select the created material from material list.

Select the tool type.

Set the feed rate/ feed per flute by numerical figure directly.

How to edit the registered material
Select the material you want to edit and double-click the item you want to edit.

After inputting numerical figure or name directly and if you push Enter key, the value or name will be changed.
Edit Registered Data

Workpiece Size

◆ Workpiece Size
Prescribed size can be registered.

How to register a new workpiece
After inputting the length and comment (workpiece characteristics, etc) in each direction of X, Y and Z in the input field of “New Workpiece” and push “Add (A)” button.
The new workpiece will be added in the list.

How to edit registered workpiece
Select the workpiece you want to edit and double-click the item you want to edit.
After inputting numerical figure or name directly and if you push Enter key, the value or name will be changed.
To input a combination of material and tool according to cut conditions information

1. Using a tool catalogue, refer to the list of tool information and cut conditions of the material you want to cut.

   Tool information

<table>
<thead>
<tr>
<th>Tool name</th>
<th>Blade diameter</th>
<th>Blade length</th>
<th>Neck angle</th>
<th>Shank diameter</th>
<th>Whole length</th>
</tr>
</thead>
<tbody>
<tr>
<td>AA-SL3</td>
<td>0.1181</td>
<td>0.5906</td>
<td>9°</td>
<td>0.2362</td>
<td>2.7599</td>
</tr>
<tr>
<td>AA-SL4</td>
<td>0.1575</td>
<td>0.7874</td>
<td>9°</td>
<td>0.2362</td>
<td>2.7599</td>
</tr>
<tr>
<td>AA-SL5</td>
<td>0.1969</td>
<td>0.9843</td>
<td>9°</td>
<td>0.2362</td>
<td>3.1496</td>
</tr>
<tr>
<td>AA-SL6</td>
<td>0.2362</td>
<td>1.1181</td>
<td>-</td>
<td>0.2362</td>
<td>3.1496</td>
</tr>
<tr>
<td>AA-SL8</td>
<td>0.315</td>
<td>1.5748</td>
<td>-</td>
<td>0.315</td>
<td>3.937</td>
</tr>
<tr>
<td>AA-SL10</td>
<td>0.3937</td>
<td>1.9685</td>
<td>-</td>
<td>0.3937</td>
<td>4.3307</td>
</tr>
</tbody>
</table>

   Table of conditions for the tool and material to be used

<table>
<thead>
<tr>
<th>Conditions table</th>
<th>Copper</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Cut speed</td>
</tr>
<tr>
<td>Tool name</td>
<td>Blade diameter</td>
</tr>
<tr>
<td>AA-SL3</td>
<td>0.1181</td>
</tr>
<tr>
<td>AA-SL4</td>
<td>0.1575</td>
</tr>
<tr>
<td>AA-SL5</td>
<td>0.1969</td>
</tr>
<tr>
<td>AA-SL6</td>
<td>0.2362</td>
</tr>
<tr>
<td>AA-SL8</td>
<td>0.315</td>
</tr>
<tr>
<td>AA-SL10</td>
<td>0.3937</td>
</tr>
</tbody>
</table>

2. Addition of manufacturer's name by Option > Edit Registered data dialog > “Tool type”: Enter the manufacturer's name.

   New Tool Manufacturer
   Name: AA-TOOL
   Add Cancel

3. Addition of tool type: Enter Type/Type name/Base diameter/Base length/ Factor 1 and 2.

   New Tool Type
   Manufacture: AA-TOOL
   Type: Square
   Type Name: Long
   Base Diameter: 0.2362
   Inch Factor 1: 1
   Base Length: 1.18110
   Inch Factor 2: 1
   Add Cancel

   Base diameter:
   Register the average value of tools daily used or the diameter of the tool you use most.

   Base length:
   Enter 5 times value (in case of resin, etc) of the registered diameter or 3 times value (harder material than resin).

   Factor 1 and 2:
   Enter 1.
4. Addition of tool by Option > Registered data edit dialog > “Tool”: Register the tool having a diameter for actual use.

Based on this tool, adjust the speed and RPM in the cut conditions table.

* Always register the Overhang length against tool diameter of the tool subject to cut conditions at the same ratio as the ratio when “Base diameter and Base length” were registered.

5. Addition of material by Option > Edit Registered data dialog > “Material/milling conditions: Register the name of subject material.
Chapter 7

6. Material/milling conditions: Select the material you want to set from material list and the tool type registered under the tool name.

Approximate the actual registering numerical figures to the cut speed/feed speed/RPM in the conditions table.

Because the cut speed is specified as "30 m/min", change it to "30" from "100".

In line with this change, RPM is also changed to "1591.5" from "5305.2".

RPM is "1600" which you can use as it is.
Next, approximate the feed speed figure to “100”.

How to obtain feed per flute amount:
Feed per flute amount = Feed speed ÷ (RPM x Number of blades)

\[ X = 100 \div (1591.5 \times 2) \]
\[ = 0.0314169 \]

If you enter the value obtained from above calculation into a feed per flute amount, a feed speed “100” will be reflected.

Registration is now complete after above procedures.

In the future, when you select the same manufacturer/same tool type and material by adding the tool to be registered, the numerical figures can be automatically calculated based on the above cut conditions.

* In case the registered tool fitting length is different from the ratio of base length:

If it becomes larger than the rbase length, the feed speed becomes slower.
If it becomes smaller than the base length the feed speed becomes faster.
Chapter 7

* If actual feed speed or actual RPM should exceed the boundary range of a milling machine:

If the upper or lower limit of feed speed of a milling machine should be exceeded, the cell color will change to yellow. The upper or lower feed speed which has been set to a milling machine will become the “actual feed speed”.

On SRP Player Pro, the milling conditions such as feed speed and RPM will be calculated and determined by the combination of material and tool.

The basic items for this calculation are the “feed rate” and “feed per flute amount” which should be set for each tool type in relation to the material.

The feed speed and RPM can be calculated as follows;

\[ \text{RPM} = \frac{\text{Feed rate}}{(\text{Tool diameter} \times \pi/1000.0)} \]

If the calculated RPM is kept within a range of upper and lower limits of RPM set under the environment setting for a milling machine, that calculated RPM becomes the “actual RPM” as it is and will be displayed in green cell. If the upper or lower limit RPM which has been set to the milling machine should be exceeded, the cell color becomes yellow and upper or lower RPM set for the milling machine becomes as the “actual RPM”.

This “actual RPM” is returned to calculate the speed.

\[ \text{Feed speed} = \text{Actual RPM} \times \text{Number of blades} \times \text{Feed per flute amount} \times \text{Factor 1} \times \frac{(\text{Tool diameter/Tool base diameter})}{2} \times \text{Factor 2} \times \frac{\text{Tool base diameter length/Fitting length}}{} \]

* Factor 1, Factor 2, reference diameter and length are the value to be set when registering.

Like RPM, if the feed speed is kept within a range of upper and lower limits of the feed speed which has been set to a milling machine, it becomes as the “actual feed speed” and will be displayed in green cell.

If the upper or lower limit of feed speed set to the milling machine should be exceeded, the cell color becomes yellow and the upper or lower limit feed speed set to the milling machine becomes as the “actual feed speed”.

Instead of using this calculation method, you can set the feed speed and RPM when the material and a specific tool have been combined.

Double-click the item in the “actual feed speed” and “actual RPM” to specify the numerical figures directly.

When the numerical figures have been directly set, the cell will be displayed in light blue color.
Notes:
(1) This manual was created by the author to include the investigation results it obtained independently.
(2) The author believes the contents of this manual are complete. In case you should find any point not clear enough or any error, etc, please inform in writing.
(3) The author is not responsible for any effect incurred by you as a result of your use of this manual.
(4) Copying any part or whole part of this manual is prohibited, unless obtaining an approval in writing from the publisher.

Trademarks:
- Rhinoceros is a registered trademark of Robert McNeel & Associates, USA and Rhino is a registered trademark of Robert McNeel & Associates, USA.
- Windows is a trademark of Microsoft Corporation, USA registered in USA and other countries.
- Any and all company names and product names referred to herein are the registered trademarks or trademarks of respective company concerned.
- Any and all names in this manual may be described in popular names or other names, which please understand.